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1.Introduction

This document explains how to add support for
additional flash devices on the Flash Programmer for
CodeWarrior™ Development Studio for Power

Architecture™ Processors by using the Flash Tool Kit.

To add support for a new flash device, you need to
write a new flash programming algorithm and create
some supporting files.

This document explains:

¢ C(Creation of a flash device XML configuration
file

* C(Creation of a new target task

¢ Creation of an external flash algorithm
¢ Flash programmer examples

* C(Creation of a new flash utility

¢ Flash utility examples

¢ Troubleshooting flash programmer
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Preliminary Background

2. Preliminary Background

Before you program or erase any flash device, you must ensure that the CPU can access it. For example,
you might need a different debug setup that requires modifications to the debugger configuration file.
Consider the following before you begin:

¢ Read the flash device ID to verify correct connection and programmability. See Troubleshooting
the Flash Programmer for instructions.

* Many manufacturers use the same flash-device algorithms, so it is likely that flashes can be
programmed using algorithms included with the CodeWarrior software. In addition, many
manufacturers produce devices compatible with Intel or AMD.

® Check whether a new flash device can be programmed with an algorithm already included with the
CodeWarrior software, as described in Select Flash Programming Algorithm.

¢ Follow the steps provided in Creating an External Flash Algorithm if the flash device cannot be
programmed with an existing algorithm.

3. Flash Tool Kit (FTK) Overview

To add support for a new flash device, you may need to create some or all of the following:

* An XML configuration file for the new device that describes organization, which is combination of
device size, bus width, and number of devices present on the board

¢ An XML configuration file for the board that specifies the flash device it must use, and tells where
the RAM memory is located

¢ A flash device algorithm if none of the existing algorithms are compatible

4. Creating Flash Device XML Configuration File

In its default configuration, the CodeWarrior™ Flash Programmer for Power Architecture supports
many flash devices. The configuration files are located at:
{CodeWarrior}\PA\bin\plugins\support\Products\ProductData\FPDevices.mw
pdb\FP

To add a new device to the CodeWarrior Flash Programmer, you must add a new file that describes the
device.

Listing 1 shows the file format.

Listing 1. Generic flash device file format

<device-file>

<device>

<content>
<name>NameOfFlashDevice</name>
<manufacturerid>MfgID</manufacturerid>

Adding Device(s) to the CodeWarrior™ Flash Programmer for Power Architecture™ Processors
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<chiperase>TRUE or FALSE</chiperase>
<sectors>

<sectorcount>NumberOfSectors</sectorcount>

<sectorsize>SectorSize</sectorsize>

<sectorcount>NumberOfSectors</sectorcount>
<sectorsize>SectorSize</sectorsize>
</sectors>
<organization>
<name>Capacity/BusWidth/NumberOfDevices</name>
<id>DeviceID ForBusWidth</id>
<algorithm>FlashAlgorithmForVariant</algorithm>
<utility>FlashUtilityForVariant</utility>
</organization>

<organization>
<name>Capacity/BusWidth/NumberOfDevices</name>
<id>DeviceID ForBusWidth</id>
<algorithm>FlashAlgorithmForVariant</algorithm>
<utility>FlashUtilityForVariant</utility>

</organization>

</content>

</device>

</device-file>

To add flash programming support for a new flash device:

1. Locate the data sheet for the new device and note the following information about the flash
device:

a) Device name

b) Manufacturer ID code

c) Device ID codes (8-bit, 16-bit)

d) Number of sectors

e) Starting and ending address for each sector

f) Whether the device can be chip erased

g) Options for data bits per device (8-bits, 16-bits)

h) Number of flash devices on target

1)  Which device is most similar in the device configurations
2. Examine the installed devices for the most similar definitions.

3. Copy/edit the definition to make the XML device files conform to the new device.

Adding Device(s) to the CodeWarrior™ Flash Programmer for Power Architecture™ Processors
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Creating Flash Device XML Configuration File

4.1. Device Name

This is a free-form text field that describes the flash device, taken directly from the data sheet. Use only
displayable ASCII characters with no spaces. Some examples, found in the configurations folder are:
AM29BDD160GT, AM29LV640M, and IN28F128J3.

The format is:

<name>NameOfFlashDevice</name>

4.2. Manufacturer ID and Device ID Codes

The Manufacturer ID and Device ID codes are read from the flash device after a specific sequence of
writes to the flash device. Although the data sheet lists both IDs, only the Device ID varies among the
flash devices from a given vendor, the Manufacturer ID remains the same. If the flash device supports
more than one bus width (8-bit, 16-bit), then it might have different Device ID for each mode. For
example, AM29LV160BB.

The formats are:

<manufacturerid>MfgID</manufacturerid>

<id>DeviceID ForBusWidth</id>

4.3. Chip Erasing

Some devices can be completely erased with one chip erase command and this is much faster than
erasing the device, sector by sector. Set the chip erase value to TRUE if your flash device supports this
feature.

The format is:

<chiperase>TRUE or FALSE</chiperase>

4.4. Number of Sectors and Sector Size

The data sheet lists the information about number of sectors and sector size. If the data sheet lists sector
maps and tables for both 8-bit and 16-bit data options, use the 8-bit data option. The CodeWarrior flash
programming algorithms require byte-level addresses for each sector. This constraint simplifies the
design of the CodeWarrior flash programming interface for several data-bus configurations and sizes.
When the data sheet does not provide a byte-level address, the algorithm creates an 8-bit sector map for
16-, 32-, or 64-bit devices. Table 1 shows an example of converting a 16-bit sector map to an 8-bit map.

The formats are:

Adding Device(s) to the CodeWarrior™ Flash Programmer for Power Architecture™ Processors
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<sectorcount>NumberOfSectors</sectorcount>

<sectorsize>SectorSize</sectorsize>

The sectorcount value is decimal while the sectorsize is hexadecimal.

For example, consider AM29BDD160GT. The device has eight (8) sectors of 0x2000 bytes, each
followed by 30 sectors of 0x10000 bytes and another eight (8) sectors of 0x2000.

The configuration file will contain:

<sectors>

<sectorcount>8</sectorcount>

<sectorsize>2000</sectorsize>

<sectorcount>30</sectorcount>

<sectorsize>10000</sectorsize>

<sectorcount>8</sectorcount>

<sectorsize>2000</sectorsize>

</sectors>

Table 1. Sector Map Conversion

16-bit Sector Map (64K word sectors)

8-bit Sector Map (128Kbyte sectors)

000000..00FFFF

00000..01FFFF

010000..01FFFF

20000..03FFFF

020000..02FFFF

40000..05FFFF

030000..03FFFF

60000..07FFFF

Older flash devices can have sectors of different sizes. If you use such an older device, ensure that each

sector in the configuration file is of the correct size.

4,5. Organization Name Options

The information that must be specified here as an organization name includes: device size, bus width,

and number of devices present on the board.

Processors
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Device size is the size of the device. It can be expressed as KB or MB using K and M suffixes.
Examples: 128K, 1M.

Many flash devices can be set to use either 8-data bits or 16-data bits depending on the status of a
configuration pin (typically named BYTE#) on each device. The <organization> field uses this part of
the flash definition, as described in the next paragraph. Your target uses only one configuration so you
need to support only that configuration. Expanding your new definition to include the other
configurations for this device, however, is a good design practice.

Your target may use one, two, or four devices at the same base address to support an 8-bit, 16-bit, 32-bit,
or 64-bit data bus.

For example, two 8-bit flash devices side by side support a 16-bit data bus, and four 16-bit devices
support a 64-bit data bus. The <organization> field summarizes each possible combination of device
capacity, bus width, and number of devices used.

For example, 4Mx16x1 means 4MegaHalfwords by 16 data bits per device by 1 flash device, resulting in
a total of 4M 16-bit half words. Similarly, 1 Mx8x4 means I MegaByte by 8 data bits per device by 4 flash
devices, resulting in /M 32-bit words and a 32-bit data bus presented to the processor.

The format is:

<organization>

<name>Capacity*BusWidth*NumberOfDevices</name>

</organization>

4.6. Find Most Similar Device

To find a device most similar to the one for which support is introduced, perform these steps:

1. From the data sheet for target flash devices, determine whether the bus width is 8- or 16- data
bits.

2. Read through the files in the configuration folder of the CodeWarrior™ Development Studio for
Power Architecture installation and scan for devices from the same manufacturer with similar
part names.

For example, AM29L V640D is similar to AM29LV641DU, and IN28F128J3 1s similar to
IN28F640J3.

3. Manufacturers often base new designs on the architecture of previous designs to ensure that new
devices are virtually the same as the previous devices. However, the new devices may have

Adding Device(s) to the CodeWarrior™ Flash Programmer for Power Architecture™ Processors
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greater capacity or improved programming features, such as timing and operation. This pattern
simplifies flash programming because the flash programming algorithms remain unchanged. Yet
only the device names, sectors, and Device IDs change.

4. Open the IN28F640J3.xml file in a text editor and compare the entries with the ones in
IN28F128J3.xml.

For example, see how the latter was built as an extension of the former. Note also how the part
number of your device may be only a revision letter different from a defined part.

For example, the flash programmer considers the AM29DL640B to be the same as the
AM29DL640D and the AM29DL640G. Thus, if you use a part number like this, program the flash
programmer to use the defined part and you will not need to create a new file.

The format is:

<algorithm>FlashAlgorithmForVariant</algorithm>

FlashAlgorithmForVariant is the algorithm name without full path (just the .elf file name).

4.7. Select Flash Programming Algorithm

Flash programming algorithms differ depending on the flash manufacturer, bits per device organization,
and the number of the flash devices used. The CodeWarrior Flash Programmer supports a number of
algorithms that are already compiled *.elf executables. These files can be found at:

{CodeWarrior}\PA\bin\plugins\support\Flash Programmer\EPPC

Create an algorithm file name by combining the fields: manufacturer, data bits per device, and number
of flash devices. For example, the flash algorithm for two AMD29LV320MB devices, used in their 16-
bit mode (BYTE# = 1), is amd16x2.elf.

The CodeWarrior™ Development Studio for Power Architecture has built-in flash programming
algorithm support for AMD and Intel flash devices. If the device does not have built-in algorithm
support, you can create your own algorithm and use it with the CodeWarrior Flash Programmer. For
more information, see Creating an External Flash Algorithm.

4.7.1. AMD-Based or Spansion-Based Flash Programming Algorithms

AMD-based or Spansion-based devices use two types of flash programming algorithms: common and
alternative.

If the flash memory device supports two types of connections, 8-bit or byte connection and 16-bit or
word connection, then use an alternative algorithm.
Processors
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In all other cases or for AMD flash devices that do not support two types of connections, use the
common AMD algorithm (Table 2).

Flash command register addresses are the main difference between common and alternative algorithms.
For example, command addresses for the common flash algorithm are: 0x555, 0x2aa, 0x555, whereas
for alternative connection, these addresses are: Oxaaa, 0x555, Oxaaa.

Table 2. AMD Algorithms
Algorithm Device(s) Address Used Algorithm File
Name

AMD One device that supports only 8-bit bus connection | 0x555, 0x2aa, 0x555 amd8x1.elf

AMD One device that supports both 8-bit and 16-bit bus 0x555, 0x2aa, 0x555 amd8xlalt.elf
connections in 8-bit mode

AMD Two devices that support only 8-bit bus connection | 0x555, Ox2aa, 0x555 amd8x2.elf

AMD Two devices that support both 8-bit and 16-bit bus | Oxaaa, 0x555, Oxaaa amd8x2alt.elf
connections in 8-bit mode

AMD Four devices that support only 8-bit bus connection | 0x555, 0x2aa, amd8x4.elf

0x555

AMD Four devices that support both 8-bit and 16-bit bus | Oxaaa, 0x555, Oxaaa amd8x4alt.elf
connections in 8-bit mode

AMD One device that supports only 16-bit bus 0x555, 0x2aa, 0x555 amd16x1.elf
connection; one device that supports both 8-bit and
16-bit bus connections in 16-bit mode

AMD Two devices that support only 16-bit bus 0x555, 0x2aa, 0x555 amd16x2.elf
connection; two devices that support both 8-bit and
16-bit bus connections in 16-bit mode

4.7.2. Intel-Based Flash Programming Algorithms

Support for Intel devices (Table 3) includes three types of flash programming algorithms:
* (3 —For Intel Advanced + Boot Block (C3)
e J3 — For Intel embedded flash memory (J3) and algorithms for Boot Block flash memory
e B3 - Advanced Boot Block (B3) flash memory families

Algorithm packages are written to comply with the J3, C3, or B3 data sheet documented functionality
from Intel for each function: Read, Write, Erase, and ID checking.

Table 3. Intel Algorithms
Algorithm Device(s) Algorithm File Name
Intel One C3 Intel flash device with 8-bit data | Intel8x1c3.elf
connection
Intel One J3 Intel flash device with 8-bit data | Intel8x1j3.elf
Adding Device(s) to the CodeWarrior™ Flash Programmer for Power Architecture™ Processors
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Algorithm Device(s) Algorithm File Name
connection

Intel One boot flash memory device or Intel8x1.elf
advanced boot (B3) flash memory
device with 8-bit data connection

Intel Two C3 Intel flash devices with 8-bit Intel8x2c3.elf
data connection

Intel Two J3 Intel flash devices with 8-bit data | Intel8x2j3.elf
connection

Intel Two boot flash memory devices or Intel8x2.elf
advanced boot (B3) flash memory
devices with 8-bit data connection

Intel Four C3 Intel flash devices with 8-bit Intel8x4c3.elf
data connection

Intel Four J3 Intel flash devices with 8-bit Intel8x4j3.elf
data connection

Intel Four boot flash memory devices or Intel8x4.elf
advanced boot (B3) flash memory
devices with 8-bit data connection

Intel One C3 Intel flash device with 16-bit Intel16x1c3.elf
data connection

Intel One J3 Intel flash device with 16-bit Intel16x1j3.elf
data connection

Intel One boot flash memory device or Intel16x1.elf
advanced boot (B3) flash memory
device with 16-bit data connection

Intel Two C3 Intel flash devices with 16-bit Intel16x2c3.elf
data connection

Intel Two J3 Intel flash devices with 16-bit Intel16x2j3.elf
data connection

Intel Two boot flash memory devices or Intel16x2.elf

advanced boot (B3) flash memory
devices with 16-bit data connection

4.7.3. Flash Manufacturers Algorithms

Many manufacturers use flash device programming algorithms that are not bundled with their own
devices. In many cases, these algorithms are same across multiple manufacturers. For example, AMIC
16x1 and AMD 16x1 flashes are programmed using the same algorithms.

Table 4 lists algorithms, device compatibility, and other information for flash manufacturers.

Processors
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Table 4. Flash Manufacturers

Manufacturer Algorithm Comments
Alliance Flash programming algorithms used for Manufacturer’s site: http://www.alsc.com/
AMD (Spansion) should be usable (check
flash device specification from
manufacturer).
AMD Algorithms are supported in the AMD does not produce its own flash devices any more —
CodeWarrior Flash Programmer founder of the Spansion Company. Manufacturer’s site:
http://www.spansion.com/
AMIC Depending on the particular flash device for | Manufacturer’s site: http://www.amictechnology.com/
flash programming, the same flash
programming algorithms used for AMD
(Spansion) or Atmel should be usable
(check flash device specification from
manufacturer).
Atmel Algorithms are supported in the Manufacturer’s site: http://www.atmel.com/
CodeWarrior Flash Programmer
Catalyst Flash programming algorithms used for Intel | Manufacturer’s site: http://www.catsemi.com/index.html
should be usable (check flash device Most of the flash devices from Catalyst are identical to the
specification from manufacturer). flash devices from Intel. For example, the CAT28F001
from Catalyst is the same as Intel E28F001.
EON Flash programming algorithms used for Manufacturer’s site: http://www.eonsdi.com/
AMD (Spansion) should be usable (check Most of the flash devices from EON have direct references
flash device specification from to the AMD flash devices.
manufacturer).
Fujitsu Flash programming algorithms used for Fujitsu no longer produces its own flash devices — founder
AMD (Spansion) should be usable (check of the Spansion Company.
flash device specification from Manufacturer’s site: http://www.spansion.com/
manufacturer).
Hyundai Flash programming algorithms used for Hyundai founded new company for semiconductors,
AMD (Spansion) should be usable (check named Hynix.
flash device specification from Manufacturer’s site: http://www.hynix.com
manufacturer). Most of the flash devices from Hynix have direct
references to the AMD flash devices.
Intel Algorithms are supported in the Manufacturer’s site: http://www.intel.com/
CodeWarrior Flash Programmer
Micron Flash programming algorithms used for Intel | Manufacturer’s site: http://www.micron.com/
should be usable (check flash device Most of the flash devices from Micron have direct
specification from manufacturer). references to the Intel flashes.
MXIC Flash programming algorithms used for Manufacturer’s site: http://www.mxic.com.tw
AMD (Spansion) should be usable (check Most of the flash devices from MXIC have direct
flash device specification from references to the AMD flash devices.
manufacturer).
Samsung Flash programming algorithms are not Manufacturer’s site:
supported in the CodeWarrior Flash www.samsung.com/products/semiconductor/OneNAND
Programmer. Samsung uses its own algorithm for flash programming,
not compatible with other vendors.
Sharp Flash programming algorithms used for Intel | Manufacturer’s site: http://www.sharpsma.com

should be usable (check flash device
specification from manufacturer).

Adding Device(s) to the CodeWarrior™ Flash Programmer for Power Architecture™ Processors
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Manufacturer Algorithm Comments

Spansion Algorithms are already supported in the Manufacturer’s site: http://www.spansion.com/
CodeWarrior Flash Programmer.

SST Depending on the particular flash device Produces flash devices compatible with Intel, AMD, and
used for flash programming, the same flash | Atmel
programming algorithms used for AMD Manufacturer’s site: http://www.sst.com/about/
(Spansion), AMD, or Intel should be usable
(check flash device specification from
manufacturer).

ST Flash programming algorithms used for Manufacturer’s site: http://www.st.com
AMD (Spansion) should be usable (check
flash device specification from
manufacturer).

Toshiba Flash programming algorithms used for Intel | Manufacturer’s site: http://www.semicon.toshiba.co.jp/eng
should be usable (check flash device
specification from manufacturer).

White Flash programming algorithms used for Manufacturer’s site: http://www.wedc.com/
AMD (Spansion) should be usable (check
flash device specification from
manufacturer).

Winbond Flash programming algorithms used for Manufacturer’s site: http://www.winbond-
AMD (Spansion) should be usable (check usa.com/mambo/content/
flash device specification from View/289/553/
manufacturer). )

4.8. Set Verify Type

The verify operation can be done in two ways: on target and on host. If the verify operation is done on
host, the CodeWarrior software reads data from the target and compares it to the one that was recently
programmed. When the operation is done on target, a flash utility and the data to be verified will be

downloaded.
The format is:

<ontargetverify>TRUE or FALSE</ontargetverify>

4.9. Set Verify after Program option

The Verify after Program option is intended to improve the user experience by reducing the time needed
to program and verify a file on the target board. Currently, the program and verify operations are
performed separately. The file is downloaded to the target for each operation (except NOR, where the
verify operation is made on the host itself), which has a significant impact on the run time. To combine
both the operations, perform the following steps:
1. Add <verifyafterprogram> tagin all the XML Flash Programmable devices.
2. The Verify after program check box appears in the Add Program / Verify Action dialog box.
It indicates that a verify operation is combined with the program operation for the file. Ensure to
select Verify after program check box.

Processors
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Figure 1. Add Program / Verify Action dialog box

Flash Devices [ use File From Launch Configuration
Dievice Mame Base Address
AMZIDLIG2CE (2Mx8x1) 0x00000000 File: | FiiLayouts_10.1.1404_10.1.1_Windows_Layout_1 108264P 4} bin\plugins|suppork! T: |
Filz Type: [Workspace... ] [File System, ., ] [Variables... ]
[ Erase sectars before program [werify after program
[CRestrict to Addresses in this Range ] Apply Address Offset
[Add Program Action ] [Add Werify Action ]

3. Click Done to close the Add Program / Verify Action dialog box.
The new operation gets listed under the Operation list of the target task window.

Figure 2. Target Task Window — Flash Programmer Actions Panel

Flash Programmer Ackions

Enabled Operation Description e
ckion <
Erase and Program Fiilayouts_10.1.1P4_10.1.1_Windows_Layout_1103261Paibin|plugins|support) Target TaskiFlash_Progr. ..
Program Fiilayouts_10.1.1P4_10.1.1_Windows_Layout_1108261Paibin|pluginslsupport) Target TaskiFlash_Progr. .. Duplicate Action
Werify Fiilayouts_10.1.14PA_10.1.1_Windows_Layout_110826\PAlbinpluginsisupportt Target TaskiFlash_Progr. ..
- Erase, Program and Yerify Fiilayouts_10.1.14PA_10.1,1 Windows_Layout 110 8\bin\plugins|support) Target TaskiFlash_Progr..,

4.10. Select Flash Utility

The flash algorithms are used for erase and program operations. Blank check, checksum, and sometimes
verify operations (depending on the value of <ontargetverify>) are done with another program,
called flash utility. If the flash device is memory mapped (NOR type), then we can use the default
FlashUtility.elf. This provides support only for blank check and checksum. The verify operation

must be done on host, so <ontargetverify> should be set to FALSE. If we have a NAND or SPI
device, then a special utility must be written. The format is:

<utility>FlashUtilityForVariant</utility>

4.11. Add Flash Device in Database

All flash devices are kept in a common database. When a flash device is added from the flash
programmer user interface, it reads the database and displays all devices found. To ensure that the
devices appear correctly, perform these steps:

1. Add the file in database
2. Change the manifest that specifies which devices exist
3. The device configuration file must be copied in

Adding Device(s) to the CodeWarrior™ Flash Programmer for Power Architecture™ Processors
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{CodeWarrior}\PA\bin\plugins\support\Products\ProductData\F PDevices.mwpdb\FP. For this
example, assume that the name is NewFlashDevice.xml.

4. Change the manifest file —

{CodeWarrior}\PA\bin\plugins\support\Products\ProductData\FPDevices.mwpdb\product-
manifest.xml.

5. Add anew section in the <device> tag that specifies a new file exists.

Listing 2 shows the beginning of the manifest file.

Listing 2. Beginning of product-manifest.xml

<?xml version="1.0" encoding="UTF-8" standalone="no" ?>
<!DOCTYPE product-manifest>
<product-manifest xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:noNamespaceSchemalLocation="http://www.metrowerks.com/schemas/2003/IDE/ProductManifest.xsd
">
<product-description>
<name>FP</name>
<common-product>FP_ EPPC</common-product>
<version>1.0</version>
</product-description>

<product-files>
<product>
<file>
<name>FP EPPC</name>
<version>1.0</version>
<path>FPDevProductData.xml</path>
</file>
</product>
<device>
<file>
<name>AM29BDD160GT</name>
<version>0</version>
<path>FP/AM29BDD160GT .xml</path>
</file>

6. Add the new file anywhere in <device> tag. For this example, it will be added at the
beginning.

Listing 3 shows the new entry marked in bold.
Listing 3. New Entry Marked in Bold

<?xml version="1.0" encoding="UTF-8" standalone="no" ?>
<!DOCTYPE product-manifest>

Adding Device(s) to the CodeWarrior™ Flash Programmer for Power Architecture™ Processors
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<product-manifest xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:noNamespaceSchemalLocation="http://www.metrowerks.com/schemas/2003/IDE/ProductManifest.xsd
">
<product-description>
<name>FP</name>
<common-product>FP EPPC</common-product>
<version>1.0</version>
</product-description>

<product-files>
<product>
<file>
<name>FP EPPC</name>
<version>1.0</version>
<path>FPDevProductData.xml</path>
</file>
</product>
<device>
<file>
<name>NewFlashDevice</name>
<version>0</version>
<path>FP/NewFlashDevice.xml</path>
</file>
<file>
<name>AM29BDD160GT</name>
<version>0</version>
<path>FP/AM29BDD160GT .xml</path>
</file>

NOTE It is highly recommended to back up the manifest file before updating it. If an error
occurs, the CodeWarrior software may not be able to parse some devices.

5.Creating a New Target Task

All Flash operations run through the Target Task Framework. To open the Target Tasks view:

1. Select Window > Show View > Other from the IDE menu bar. The Show View dialog box
appears.

2. Select Debug > Target Tasks. The Target Tasks view appears.
Next, create a Flash Programmer task representing the starting point for any flash operation. This defines
the flash device to be used and the memory buffer, and creates some default actions.

5.1. Create a New Target Task

To create a new task, perform these steps:

1. Click the Create new target task (“+) icon on the Target Tasks view toolbar, as shown in
Figure 3.

Adding Device(s) to the CodeWarrior™ Flash Programmer for Power Architecture™ Processors
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Figure 3. Create a New Target Task Icon

I i
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2. The Create New Target Task wizard appears (Figure 4). Specify information in the following
fields:

e Task Name: Name of the target task.
e Task Group: Group where the task is to be created. If only Root exists this option is disabled.

¢ Run Configuration: Each task must be associated with an existing Launch Configuration or
Active Debug Context. This association is required to be able to make a connection to the
target when doing operations over the flash. Active Debug Context means a connection is
already established and only the task needs to be executed. Use Active Debug Context for
generic tasks or when it is not known which Launch Configurations are available.

e Task Type: Type of task created. For Power Architecture, select Flash Programmer for Power
Architecture.

Adding Device(s) to the CodeWarrior™ Flash Programmer for Power Architecture™ Processors
Freescale Semiconductor 15




A ———
Creating a New Target Task

Figure 4. Create New Target Task Wizard
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3. Click Finish. The editor for the new task appears.

5.2. Add a Device

To add a flash device to the Flash Devices table in the Flash Programmer Task editor, perform these
steps:

1. Select the Flash Programmer task to which you want to add a Flash device.
2. Click Add Device in the Flash Programmer Task editor (Figure 5).

Adding Device(s) to the CodeWarrior™ Flash Programmer for Power Architecture™ Processors
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Figure 5. Add Device in Flash Programmer Task Editor

-
47 MewFlashTask 52 =

PA Flash Programmer Task

Flash Devices Target RAM

Device Name Base Address Address: Ox | 0O00DOOOD
Size: 0z | 0000000

|:| werify Target Merory Writes

I[Add Device ]I I_Remove Device

Flash Programmer Actions

Enabled = Operation Description
= E Add Action

Duplicate Action
Remove Ackion
Maove Up

Mawve Down

Flash ActionJ

The Add Device dialog box appears (Figure 6).

3. Select the new device, named NewFlashDevice in this example, and check the available
organizations. Here, AMD16x1 is defined. If more than one device is present, then select the
devices that suit the board where the task will be executed.

4. Click Add Device. Both of them are shown in Figure 6.
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Figure 6. Select Organization and Add Device Button

b —_x.
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AMZ9DL323CE 4MxEx1
AMEZDLF23CT 4MxGx1
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AMZ9F004EE S12KxaExl
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AMZ9F016R 2Mx3x1
AMZ9F017E 2MxEx1
AM29F052E 4MxGx1
AMEZSF040E E12Kxax1
AMZ9F0S0R 1Mx3x1 b
| Add Device I Done

A pop-up window displays indicating that the device has been added.
5. Click Done. The selected devices are added in the Flash Devices table.

5.3. Populate Default Values

Ensure that the following default values are populated correctly for the flash devices specified in the
target task:

e Base Address: Specifies that the flash device is memory mapped and this address must be defined
in the “Flash Devices” table next to device name.

* Address in Target Ram panel: Specifies the start address of the memory where an algorithm is
downloaded on the target for performing operations on the flash devices.

¢ Size: Specifies size of the memory buffer for algorithm. The size must be large enough to fit the
algorithm and data that must be programmed. In case the buffer is not big enough, an error will be
displayed when executing the task. The smallest size needed is specified in the Size field.

Adding Device(s) to the CodeWarrior™ Flash Programmer for Power Architecture™ Processors
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* Verify Target Writes: Checks if the memory is correctly written. This is done by reading the
memory written after each write command. This allows you to check if the RAM memory is
correctly initialized. By default, it comes unchecked due to the loss of speed that comes with the
overhead of reading memory each time.

All these values must be correct for the board where the flash device is located. Figure 7 shows the
default values for board P1024RDB with K9F5608U0D NAND flash device. All fields that must be
filled are highlighted with red.
Figure 7. Populate Default Values

7 P1024RDE_MAND_FLASH 53 =8

PA Flash Programmer Task

Flash Devices Target RAM
Dievice Mame Base Address Address: 0x | 00002000
¢ KOFSE08UI00 {32MxEnl) Q00000000 ; Sz 0% | D0030000

|:| verify Target Mermary Writes

Add Device ] [Remove Device

Flash Pragrammer Actions

Enabled = Operation Description
£ £ Add Action e

Flash action

5.4. Create Default Actions
The various flash programmer actions that can be added to a target task are:
e Erasing the whole flash device using Chip Erase
¢ Blank checking the whole device
¢ Programming the file from Launch Configuration used to connect to the target

¢ Verifying the file from Launch Configuration used to connect to the target

Each target task supplied with CodeWarrior has the following target tasks:
¢ FErase
¢ Blank check
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* Program

e Verify

¢ Checksum
¢ Diagnostics
¢  Dump flash
* Protect

¢ Unprotect

* Secure

¢ Unsecure
All these operations can be selected using Add Action button. In the below steps, this step is not
mentioned to avoid the repetition.

You can associate the above actions with the target task using the buttons in the Flash Programmer
Actions section in the Flash Programmer Task editor. You can arrange the order of the actions using the
Move Up/Move Down buttons.

PA Flash Programmer Task

Flash Devices Target RAM
Device Name Base Address Address: Ox | 00002000 |
KOFSE03U00 (32Mxdxl) 000000000 Sz O | 00030000 |

|:| Werify Target Memary Writes

Add Device ] [Remwe Dievice

Flash Programmer Actions

Enabled Cperation Descripkion Add Action -
Duplicate Action
Flash Action
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5.4.1. Erase/ Blank Check Action

The erase action is added with Add Erase / Blank Check Action button. The dialog box shown in
Figure 8 will be displayed.

The Add Erase Action button enables you to erase a selected sector from the flash device and the Add
Blank Check Action button checks the erased sectors to verify if they have been fully erased.

To add an erase / blank check action, follow these steps:

1.
2.

Select the Flash Programmer task to which you want to add erase/blank check actions.

Click the Add Erase / Blank Check Action button in the Flash Programmer Task editor. The
Add Erase / Blank Check Action dialog box appears.

Select the flash device to which you want to add the erase/blank check action.

Select a sector from the Sectors table and click Add Erase Action to add an erase operation on
the selected sector. You can select multiple sectors by holding Ctrl key while selecting the
sectors.

Select a sector from the Sectors table and click Add Blank Check Action to add a blank check
operation on the selected sector.

Check the Erase All Sectors Using Chip Erase Command check box to erase entire flash. To
erase only a part of the device, leave it unselected and select only some of the sectors. If the size

of the file to be programmed is unknown (for example, for an e1 £ file, where only the necessary

sections are downloaded on the flash), then you can use “Erase sectors before program” option.

Using this option is better than erasing the entire flash, because for NAND flashes, the erase
operation will fail if bad blocks are found. Also, to write something in flash, you need to erase it
first or you will not be able to write the new information.

NOTE For more details on these operations, see Flash Programming Algorithm for AMD 16x1
Flash Devices.

Processors

21



A ———
Creating a New Target Task

Figure 8. Add Erase / Blank Check Action Dialog

Add Erase / Blank Check Action _X]
Flash Devices Erase all Sectars Using Chip Erase Command
Device Mame Base Address Sectaors
KAFSA0E00 (32MxE:1 ) O=0000000a
Sectors Counk Start End L
Sa0 000000000 0x=00003FFF B
sa1 000004000 0x=00007FFF
282 000003000 0x=00006FFF
SA3 0=0000C000 0=0000FFFF
Sa4 000010000 0=00013FFF
245 000014000 0=00017FFF
SAG 0=00015000 0x0001BFFF
SA7 00001000 0x0001FFFF
285 Ox=00020000 0=00023FFF
549 Q00024000 000027 FFF
Sal10 000025000 0x0002EFFF
Sal11 Q0002000 0=0002FFFF
2412 000030000 0=00033FFF
SA13 0=00034000 0=00037FFF
Sal4 000035000 0x=00036FFF
2415 00003000 0x=0003FFFF
Sala O=00040000 0=00043FFF
Sa17 000044000 00004 7FFF
Sa18 000045000 0=0004EFFF
SA19 Q0004000 0x0004FFFF
Saz20 000050000 0x=00053FFF
821 000054000 0=00057FFF
2822 000055000 0x=00056FFF
SAZ3 0=0005C000 0x0005FFFF
SaZ24 O=00060000 0=000635FFF b
’_.ﬁu:ld Erase Action ] [.ﬁ.dd Blank Check Action ] [Done ]

7. Click Done to close the Add Erase / Blank Check Action dialog box. The added erase / blank
check actions appear in the Flash Programmer Actions table (Figure 9).
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Figure 9. Erase and Blank Check Actions Added

PA Flash Programmer Task

Flash Devices Target RAM
Dievice: Marne Base Address Address: 0xx | 00002000
KAFSE03U00 {32Mxx1) 000000000

Size: 0x | 00030000
|:| Werify Target Memory Writes

Add Device ] [Remove Device

Flash Pragranmer Actions

Efanieg CIperatot [BL=2=0nli | ] i

: A Add Action =
Erase K9FS&08U0D using chip erase.
Blank Check  KOFS&08U0D Duplicate Action

Flash Action

5.4.2. Add Program / Verify Action

The Add Program / Verify Action button enables you to add program or verify flash actions for a flash
device. To add a program or verify action, perform these steps:

1. Select the Flash Programmer Task to which you want to add program or verify actions.

2. Click Add Program / Verify Action in the Flash Programmer Task editor. The Add Program
/ Verify Action dialog box appears.

3. Select the flash device to which you want to add a program or verify an action. In case the board
has multiple flash devices, then the destination must be selected.

4. Check the Use File from Launch Configuration check box if you want to program/verify the
launch configuration file. Alternatively, specify the file name and file path in the File text box or
click the Workspace, File System, or Variables buttons to select the desired file.

* Click the Workspace button to select a file from the current Eclipse workspace

¢ Click the File System button to browse through the Windows file system and select the
file

¢ C(lick the Variables button to insert variables in the path

5. Define how the file should be read by selecting appropriate option from the File Type drop-down
list. The following options are available:
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* Auto: The Flash Programmer detects files of type Elf and Srec
¢ EIf: Elf executable file
* Srec: Motorola .s19 file format

¢ Binary: The file is read in binary format, no content interpretation is done

6. Check the Restrict to Addresses in this Range check box to define a range for flash accesses.
Any program/verify action performed outside this range is ignored. You can specify the range in
the Start and End text boxes, respectively.

7. Check the Apply Address Offset check box to apply an offset to the image to be written to the
flash device. You can specify the offset in the Address text box. This value is added to the
(computed) start address of the file.

The start address is zero for binary files or read from the file header. In case you want to use a

binary file and the flash is not mapped to zero, then enable the offset and set the value to the base
address of the flash.
The settings are displayed in Figure 10.

8. Click Add Program Action to add a program action for the flash device.
9. Click Add Verify Action to verify an action for the flash device.
10. Click Done to close the Add Program / Verify Action dialog box.

Figure 10. Add Program / Verify Action Dialog Box

Add Program, f Verify Action &|
Flash Devices I Ise File from Launch Configuration I
Dievice Marme Base Address
KOFSA0ELIOD (32Muxdx1 ) 0x00000000 | |

[IErase sectors before program

[ Restrict bo Addresses in this Range [ ] apply address Cffset

[ooosoon ||| acoressiox [omooooon |
[owrere ]

[.ﬁ.dd Program Action ] ’.t'-\dd Werify Action l [Done ]

The added program / verify actions appear in the Flash Programmer Actions table as in the Figure 11.
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Figure 11. Flash Programmer Actions Table

PA, Flash Programmer Task

Flash Devices

Target RAM
Device Marne Base fddress Address: Ox | 00002000
K9FS608LI0D (32Mudi1) 0x00000000 cize: 0% | 00030000
|:| verify Target Memory Writes
Add Device ] [Remove Device
Flash Pragrammer Actions
Enabled Operation Description
; - 5 . . ] Add Action e
Erase KIFSE0EU00 using chip erase,
Blark Check K9FSE08LU0D Duplicate Action
Erase and Program file From launch configuration in KIFSE0EU00 using address offset 0x00000000
werify file: from launch configuration in KIFSE08U0D using address offset 0x00000000
Flash action

The task is now complete and should be saved using Ctrl + S or Save icon from toolbar.

5.5. Export the Target Task

The final step is to export the task to an .xml file. This allows us to import the task later or from another
machine. To export a task, perform these steps:

1. Inthe Target Tasks view, select the task you want to export. Right-click the task and select
Export as shown in Figure 12. Alternatively, click the Export icon available on the Target

Tasks view toolbar.
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Figure 12. Export Target Task

'0@ Target Tasks &3 r_& Problems i] Executables | &5 Progress Jﬁ Remoke Syskems E. Tasks | Bl Consale
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Renarme
|:= Duplicate
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&7 Edit Task Configuration
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The Save As dialog box appears.

2. Browse to the desired location, specify the file name, and click the Save button.
The saved task can be imported later using the Import button on the Target Tasks view toolbar.

6. Creating an External Flash Algorithm

6.1. Flash Tool Kit (FTK) Overview

The Flash Tool Kit helps you develop flash programming algorithms for the CodeWarrior Flash
Programmer, as shown in Figure 13. This section provides important information needed before you
begin creating a flash programming algorithm.
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Figure 13. Flash Tool Kit
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6.2. Flash Tool Kit General Structure

The flash programmer Flash Tool Kit (FTK) application is divided into three different sets of files:

e FTK Common Files (No Modification Needed): Includes initialization and other files. This
component is common for all flash devices and should not be changed while developing the new
flash programming algorithm. It consists of the following files:

o flash algorithm.lcf: The linker command file. This file is set up according to the
rules for the flash programming applet allocation in physical memory.

o flash commands.h: The header file with API to the CodeWarrior Flash Programmer
commands definition.

o generic.h: The header file with the generic data structures and definitions used by the
flash programming algorithms.

flash main.c: The main function and API to the CodeWarrior Flash Programmer.

flash exis.s: The exit point for the flash programming applet.

e User Files (Implement Algo): Includes the flash device specific files. This component is modified
for any flash devices depending on the flash programming algorithm to be used. It consists of the
following files:

o algo impl.c: It functions to implement for the flash device flash algorithm, such as ID,
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erase_sector, erase_chip, write.

e Run-time files:

o ppc_eabi init.c: The flash programmer start-up initialization file.

To create the new algorithm for flash programming, make all changes to the algo impl.c (flash
device algorithm implementation).

6.3. Flash Tool Kit Build Targets

Several build targets are predefined in the Flash Tool Kit (FTK):

¢ Flash Algo Development: The flash algorithm development and test application. The ELF
executable file, created in Flash Algo Development, should be used to develop, debug, and test the
new CodeWarrior Flash Programmer algorithm.

» Flash Algo Release: To create flash algorithm applet, the CodeWarrior Flash Programmer uses the
ELF executable file, created in Flash Algo Release. This build target shares the flash device
algorithm with the Flash Algo Development build target; it differs, however, because it cannot be
debugged or tested (Figure 14).

Figure 14. Flash Tool Kit Targets

= Properties for. FlashToolKitTemplate

| | C/C++ Build - .
Resaurce
Builders
CIC++ Build Build configuration; | Flash Algo Development [ Active ] ¥ | | Manage Configurations. .,
CIC+H+ General Flash Algo Development [ Active
Project References Flash Algo Release

[ All configurations ]
| Bulder settings | © Behaviour

Refactoring History
Run/Debug Settings

Builder

Builder kype: | External builder v

s default buid command

6.4. Flash Programmer API

The CodeWarrior Flash Programmer communicates with the flash programming algorithm applet
through five different commands:

e getID

® erase sector
e crase chip

® program

e verify
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The CodeWarrior Flash Programmer uses an exchange zone in target memory to communicate with the
flash applet. The Flash Programmer Target Configuration specifies the Target Memory Buffer; the
exchange zone is at the start of this buffer, as shown in Figure 15.

Figure 15. Target Configuration Buffer Memory Area Start Address

Flash Devices Target RAM
Device Mame Base Address Address: Ox | 00002000
MewFlashDevice (1Mx16x1) OxFFEDOOOD Siza: o | oonzooon

|:| werify Target Memary Writes

Add Device ] [Remwe Device

Flash Programmer Actions

Enabled Operation Descripkion .
Add Action w7
Erase fram MewFlashDevice ranges: {0xFFEFO000 - OxFFEFFFFF),
Blank Check fram MewFlashDevice ranges: {0xFFEFO000 - OxFFEFFFFF),
Erase and Program file From launch configuration in NewFlashDevice using address offset 0xFFEQOOOD
Werify file From launch configuration in MewFlashDevice using address offset 0xFFEQOOOD

Parameter_block_t Structure

For the detailed description of the Parameter block t structure, see Listing 4.

Listing 4. Parameter_block_t structure details

typedef struct pb {

unsigned long function; /* What function to perform ? */
pointer t base addr; /* where are we going to operate */
unsigned long num items; /* number of items */

retval t result status;

pointer t items;

unsigned long is timebase enabled;

unsigned long padding[3]; /* Padding for CheckSpeed Parameters - these are not used
for PA & SC - only for MCU (added already in every generic.h MCU algorithm)*/

unsigned long ccsrbar; /* Base address for memory mapped registers */

unsigned long core type; /* Core Type - used for handle between different
processor FP controller structs */

unsigned long controller offset; /* Controller Offset */

unsigned long controller type; /* Controller Type */

unsigned long paddingl[37]; /* Padding for the gap space between params proc and
Additional params*/
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unsigned long additionalParameterNum; /* number of additional parameters sent by FP
Plugin */

unsigned long additionalParameterStart; /* start address for Additional parameters
*/unsigned long padding2([7]; /* Padding for other additional parameters*/

} parameter block t;

Listing 4 definitions:

Function: Command to be executed from the CodeWarrior Flash Programmer.
base addr: Start address of the flash memory.

num_items: Number of items to be transferred from the CodeWarrior Flash Programmer to the
flash programming applet.

result status: Status of the command; through this field, the flash programming applet
notifies the CodeWarrior Flash Programmer about the status of the command being executed.
Some values for result status are defined in generic.h; however, the user can define
more, if needed.

items: Start address of the data to be transferred from the CodeWarrior Flash Programmer to the
flash programming applet.

Is timebase enabled: A time-out mechanism can be implemented in the algorithm if
timebase is enabled.

Padding[3]: Used only for internal purposes.
Ccsrbar: Base address for memory mapped registers.

Core type: Used for handling different processor FP controller structures (can be e500v1, e500v2,
and so on — see generic.h for all macro values).

Controller offset: controller offset address

Controller type: Controller type (can be eLBC, IFC, eSPI, and so on — see generic.h for all macro
values).

Paddingl : Used only for internal purposes.
additionalParamenterNum : Number of additional parameters sent by FP plugin.
additionalParamterStart : Start address for additional parameters.

Padding2 : Padding for additional parameters.

NOTE items and base addr are of type pointer t, which is a union that can
accommodate different types (such as char *, short *). This arrangement
makes the algorithm scalable, so it can be used for 8-bit, 16-bit, or 32-bit flash.
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30

Freescale Semiconductor



creating an External Flash Algorithm

ID
The CodeWarrior Flash Programmer uses the getting chip ID command right after the flash
algorithm is loaded to the memory buffer to check if the applet runs. For the ID command,
the CodeWarrior Flash Programmer:
¢ Loads the flash programming applet to the target board
e Sets the command ID, as shown in the function field of Listing 4
* Runs flash programming applet
e Waits while flash applet stops execution
* Checks the status of the command being executed, as shown in the
result status field of Listing 4
fEraseChip
The full chip erase command is called by the CodeWarrior Flash Programmer when a full
chip erase is performed. For the fEraseChip command, the CodeWarrior Flash
Programmer:
¢ Loads the flash programming applet to the target board
e Sets the command fEraseChip, as shown in the function field of Listing
4
¢ Runs the flash programming applet
¢ Waits while the flash applet stops execution
* Checks the status of the command being executed, as shown in the
result status field of Listing 4
NOTE Some flash devices do not support the full chip erase command. Check the flash device’s
specifications, available from the manufacturer.
fEraseSector

The CodeWarrior Flash Programmer calls the sector erase command to erase a set of flash
memory sectors. For the fEraseSector command, the Flash Programmer:

Loads the flash programming applet to the target board
Sets the command fEraseSector, as shown in the function field of Listing 4

Specifies number of blocks to be erased, as shown in the num_items field of
Listing 4

Specifies start-up address of each block to be erased, as shown in the items field of
Listing 4

Runs flash programming applet
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e Waits while flash applet stops execution

* Checks the status of the command being executed, as shown in the result_status
field of Listing 4

fWrite
The fWrite program buffer command is called by the flash programmer to program a set of
values at a specific address. For the fWrite command, the CodeWarrior Flash Programmer:
¢ Loads the flash programming applet to the target board
* Sets the command fWrite, as shown in the function field of Listing 4
* Specifies number of bytes to be programmed, as shown in the num_items field of
Listing 4
* Specifies start-up address of data to be programmed, as shown in the items field of
Listing 4
¢ Runs flash programming applet
e Waits while flash applet stops execution
* Checks the status of the command being executed, as shown in the result_status
field of Listing 4
fVerify

The fVerify command is usually not implemented in flash algorithms. For all NOR flash
devices, a separate application (flash utility.elf) performs verification. Your
CodeWarrior product includes this program. This application reads memory from the target
and compares each returned value with the desired value.

However, you can enable the fVerify command by modifying the flash device's XML
description file. If you make this change, the verify operation is done by the flash algorithm.
For NAND and SPI flash devices, the verify operation must be done by the flash algorithm
because for these flash devices, verification cannot be achieved just by reading memory.

6.5. Create a New Flash Programming Algorithm

This section provides you step-by-step instructions on how to use the Flash Tool Kit to create a new
CodeWarrior Flash Programmer flash programming algorithm for a flash device, which is not integrally
supported by the CodeWarrior software. The steps are given below:

1. Store original versions of the Flash Tool Kit files from the CodeWarrior delivery to some
directory on your machine.

2. Copy FlashToolKitTemplate folder from {CodeWarrior}\PA\PA Tools\
FlashToolKit\FlashToolKitTemplate to a different directory, where
CodeWarriorInstallDir specifies the location where the CodeWarrior software is installed.

Adding Device(s) to the CodeWarrior™ Flash Programmer for Power Architecture™ Processors
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3. Import Flash Tool Kit Template project:
a) Select File 2 Import. The Import dialog box appears.

b) Select General - Existing Projects into Workspace and click Next. The Import
Projects page appears.

c) Click Browse to select the parent folder where you have copied the
FlashToolKitTemplate folder.

d) The Projects list will show all available projects in the FlashToolKitTemplate
folder. If you see projects other than FlashToolKitTemplate, then deselect all other
projects and click Finish.

e) Ensurethe Flash Algo Development build target is selected.
Select Run = Debug Configuration. The Debug Configuration dialog box appears.
Expand the CodeWarrior Download tree node and select the desired launch configuration.
Click the Debugger tab in the right panel.

Select the required target processor from the Target Processor drop-down list.

© Nk

Specify required target initialization and memory configuration files for the connected hardware
in the Target initialization file and Memory Configuration File text boxes.

a) For supported Freescale Evaluation Boards, you can use the debugger configuration files
(*.tcl), and the debugger memory files (*.mem) available with the CodeWarrior
Development Studio:

{CodeWarrior}\PA\PA Support\Initialization Files

NOTE In case of custom hardware design, the debugger configuration file and the memory
mapping file must be written. Also, the memory initialization file for the flash device
should be checked before trying to create the new flash programming algorithm.

9. Modify the algo impl. c file:

a) The flash algorithm functionality file, algo impl. c, should be modified and filled
with the correct programming commands, as recommended by the flash device
manufacturer.

10. Modify ID function in the algo_impl.c file:
a) By default, the ID function in the algo impl. c file looks as shown in Listing 5.
b) The following definitions pertain to Listing 5:

- parameter block t *p pb — Pointer to the parameter_block t structure to be
passed to the ID function

- retval t —Resultof the function execution

c) The correct command sequence should be created for the ID function based on the
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recommendations of the flash device manufacturer, as described in Implementing ID
Function for AMD 16x1 Flash Devices.

Listing 5. ID function template in algo_impl.c file

retval t ID(parameter block t *p pb)
{ _ _ _ _

retval t result = 0;

volatile unsigned long* item addr = (p pb->items).l;

/* Add code: the correct access size depending on the bus must be used for the base addr
*/

volatile unsigned short *base addr = (p pb->base addr) .w;

/* Add code: first of all reset the device.

The fID is not called in the new flash programmer plugin therefore
the flash chip must always be brought into the read state.

*/

/* Add code: read the device ID */

/* we currently assume that we have the right value */
/* anyway, the IDE have to care about the flash ID and compare with the xml file */
return result;

11. Modify the erase sector function:
a) By default, the erase sector function in the algo impl. c file appears as shown
in Listing 6.
b) Listing 6 definitions:

- parameter block t *p pb — Pointer to the parameter_block_t structure to be
passed to the erase sector function

- unsigned long sect index — Index of the sector to be erased
- retval t —Resultof the function execution

c) Based on recommendations from the flash device manufacturer, the correct command
sequence must be created for flash-sector erasing, as described in Implementing
erase_sector Function for AMD 16x1 Flash Devices.

d) For some NOR flash devices, you can check if the sector you want to delete is protected;
this verification is described in Implementing erase_sector Function for AMD 16x1 Flash
Devices.

Listing 6. Function template erase_sector in algo_impl.c

retval_t erase_sector (parameter block t *p_pb, unsigned long sect_index)

{
int timed out, got it;
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retval t result = 0;
/* Add code: the correct access size depending on the bus must be used for the base addr
volatile unsigned short *base addr = ((unsigned short **) (p pb->items) .w) [sect index];
/* Add code: verify if the sector is protected */
/* Add code: first of all reset the device.
The fID is not called in the new flash programmer plugin therefore
the flash chip must always be brought into the read state.
*/
/* Add code: erase one sector */
/* Add code: wait for status */
/* Add code: handle error (and timeout if needed) */

/* Add code: put back the flash in read state */

return result;

12. Modify the erase chip function:

a) By default, the erase chip function in the algo impl. c file looks as shown in Listing
7.

b) Listing 7 definitions:

o parameter block t *p pb: Pointer to the parameter block_t structure to be
passed to the erase chip function

o retval t: Resultof the function execution

c) Create the correct command sequence for full flash chip erasing based upon
recommendations from the flash device manufacturer, as shown in Implementing
erase_chip Function for AMD 16x1 Flash Devices.

d) For some NOR flash devices, you can check if any of the sectors are protected; this
verification is described in Implementing erase sector Function for AMD 16x1 Flash
Devices.

Listing 7. Function template erase_chip in algo_impl.c

retval t erase_chip (parameter block t *p pb)

{

int errors = 0;
retval t result = 0;
unsigned short stat;
int got it;
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*/

/* Add code: the correct access size depending on the bus must be used for the base addr
volatile unsigned short *base addr = (p pb->base addr) .w;
/* Add code: verify if the sectors are protected */
/* Add code: first of all reset the device.
The fID is not called in the new flash programmer plugin therefore
the flash chip must always be brought into the read state.
*/
/* Add code: erase one sector */
/* Add code: wait for status */
/* Add code: handle error (and timeout if needed) */

/* Add code: put back the flash in read state */

return result;

13. Modify the write function:
a) By default, the write function in the algo impl. c file looks as shown in Listing 8.
b) Listing 8 definitions:

o parameter block t *p pb: Pointer to the parameter block t structure to be
passed to the write function

o retval t: Resultofthe function execution

c) Create the correct command sequence for flash device programming according to the
recommendations of the flash device manufacturer, as described in Implementing write
Function for AMD 16x1 Flash Devices.

d) For some NOR flash devices, you can check if any of the sectors that are involved in the
writing process are protected; this verification is described in Implementing erase_sector
Function for AMD 16x1 Flash Devices.

Listing 8. Function template write in algo_impl.c

retval t write(parameter block *p pb)

{

*/

int timed out, got it;

unsigned long i;

unsigned short stat;

retval t errors = 0;

/* Add code: the correct access size depending on the bus must be used for the base addr
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volatile unsigned short *base addr = (p pb->base addr) .w;
/* Add code: verify if the sectors involved in the writing process are protected */

/* Add code: first of all reset the device.

The fID is not called in the new flash programmer plugin therefore
the flash chip must always be brought into the read state.

*/

/* Add code: program the bytes pointed in the buffer : p pb->items,
they are p pb->num items bytes
handle error (and timeout if needed) for each of the program sequence

*/

/* Add code: put back the flash in read state */

return errors;

}

NOTE See the flash device manufacturer for the flash device memory organization. See
hardware description for the flash device addressing.

14. Compile Flash Algo Development target:

a) During new algorithm creation and testing, use the Flash Algo Development build target
of the Flash Development Kit. Compile the Flash Algo Development target with the
flash algo.c file, which is modified for the flash programming procedures.
Compilation will result in creation of anew flash alg debug.elf file.

15. Flash algorithm unit test:

a) To test a flash programming algorithm, define custom flash device parameters in
flash_main.c. You can select the operation you want to perform and the address in flash
to which the operation will be applied.

16. Compile Flash Algo Release target:

a) When the flash programming algorithm for the new flash device works correctly (as
confirmed in unit testing), compile the Flash Algo Release target. The output of the Flash
Algo Release target — flash alg release.elf — must be copied to the
following folder:

{CodeWarior}\PA\bin\plugins\support\Flash Programmer\EPPC

17. Add a new flash device to the flash programmer:

a) See Creating Flash Device XML Configuration File for information on adding a new
flash device.
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18. Create a new default target task:

a) See Creating a New Target Task for information on creating a new default target task.

19. Set flash device configuration in flash programmer:

a) Restart the Eclipse IDE so that the Eclipse IDE can use the new data from the updated
manifest file.

b) Select Window > Show View > Other... > Debug > Target Tasks from the menu bar to
open the Target Tasks view.

c) Right-click the Tasks table and select Import from the context menu (Figure 16).

. . ey . . .
Alternatively, click the = icon on the Target Tasks view toolbar to import a task. The
Open dialog box appears.

Figure 16. Import Task

‘8| Target Tasks 53 W New Task LN i
[== Mew Task Group

Arrange ByviTask Groups - =] T:

...... = Root E REnare Tvpe | Run
- Duplicate
W Delete

. Execiute

’ Edit Tiask Configuration

Chiange Run Configuration

4+ Move up
¥ Move down

|g=g Impork 1§

[ Export

<

d) Browse to the location of the task that you want to import, select the required task, and
click Open. The imported task gets added to the Tasks table.

e) Make a new Download Run Configuration (Right-click the project, select Debug As ->
Debug Configurations) specific for your board (below is an example for P1024RDB)

- Select the project — Flash Tool Kit Template and the debug application
flash alg debug.elf
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= Properties for P1024RDB_Download

System

2 Properties for P1024RDB__
[CusE serial number:

System
ITAG settings

ITAG dock speed (kHz): | 1000 RSE system bype: Hardware or Simulator System

Farent profile: Zrol3-ws326

System hd
RSE system type: Hardware or Simulator Connection s
Parent profile: zrol3-ws 326
Name: | P1024RDE_Download |
Description: | P1024RDE_Download |
Systern: PLOZ4RDB_ v m Edt., | wew. |
Connection type: |USB TAP |

Connection | Advanced
USE TAP

CCS server

() Automatic launch MName: | PLO24RDE__ |
Server port number: IE Description: | |
[[] ccs executabls:

(2 Manual launch System type: | Flozd

[iz7od
[os7s |

Initialzation | system |

[C]Execute system resst (appliss ko initial launch only)

System Run out of reset Initialize: karget Initislize karget scripk
= PLO24
e500v2-1 O

Mote: Target initislization files only apply ko cores being launched,

Connection type (usb, etap, gtap).

Make a new connection — select the Initialization file (refer step 5), the System and

f) Check the Initialize target check box to select the Initialize target script for core0 from
the system list. Right-click the imported task and select Change Run Configuration

(Figure 17).

Figure 17. Change Run Configuration

Target Tasks &3

Arrange By:Task Groups = = Tasks

a

=5 Mew Task
[~ Mew Task Group

Rename
|:=| Duplicate
¥ Delete

. Execute

hange Fun Configuration

g) The Run Configuration dialog box appears. Select the Run Configuration from the drop-

down list and click OK.
h) Double click the task to open the task in the editor area.
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1) Check if the flash device used is the newly introduced. As an example, the device has
been named NewFlashDevice (Figure 18).

Figure 18. Flash Task Editor

Flash Devices Targek RAM

Ty — Base Address Address: Ox | 00002000
MewFlashDevice (1Mx16x1) 0xFFEOODOD Size: 0x | 00020000

|:| ‘erify Target Memary Wites

Add Device ] [Remove Device

Flash Programmer Actions

Enabled Operation Description .
Add Action hd
Erase from MewFlashDevice ranges: (0xFFEF000 - 0xFFEFFFFF).
Blank Check From MewFlashDevice ranges: (0xFFEFO000 - OxFFEFFFFF), Duplicate Action
Erase and Program file from launch configuration in MewFlashDevice using address offset 0xFFEOO000
Werify file from launch configuration in MewFlashDevice using address offset 0xFFEOO000 Remove Ackion
Move Up
Move Down
20. Erase and blank check the device:
a) Select only Erase and Blank Check actions (Figure 19).
Figure 19. Erase and Blank Check actions selected
Flash Devices Target RAM
Desvice: Narne Base Address Address: 0x | 00002000
MNewFlashDevice {1Mx16:x1) 0xFFEQODO0 Size o | nonennan

|:| Werify Target Memory Writes

Add Device l [Remove Device

Flash Programmer Ackions

Enabled Operation Diescription )
Add Action B
Erase from MewFlashDevice ranges: (0xFFEF0000 - 0xFFEFFFFF),
Blank Check from MewFlashDevice ranges: (OxFFEFD000 - OxFFEFFFFF). Duplicate Action
[ Erase and Program file from launch configuration in MewFlashDevice using address offset DxFFEQDDOD
E- erify file From launch configuration in MewFlas! FFset OxFFEQOOOD Remowe Action

Move Up

Mowve Diawn

b) Save the task by pressing Ctrl + S or choosing Save button from toolbar.
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c) Select Window > Preferences from the IDE menu bar. The Preferences dialog box
appears.

d) Select C/C++ > Debug > CodeWarrior Debugger and check the Show verbose output in
Target Tasks check box in the CodeWarrior Debugger panel.

e) Right-click the task and select Execute (Figure 20).

Figure 20. Execute the task

‘8] Target Tasks 2 =0 % Sﬁ g4+ & Y 70O
Arrange By:Task @roups = = Tasks /
= Poot a i i

e g

= MNew Task
== New Task Group

Rename
|-= Duplicate
¥ Delete

& Edit Task Corfiguration
Change Run Configuration

f) The Flash Programmer Console appears in the Console view and the task log gets
printed there.

g) Check for the algorithm used in console log. The section from Listing 9 should be
present.

Listing 9. Algorithm used for Erase operation

cmdwin::fl::erase all
Beginning Operation ...

log: Using Algorithm: flash alg debug.elf

h) Check in the log if the task is successful. The lines from Listing 10 should be present.

Listing 10. Part of Erase and Blank Check actions log

Erasing . ...ttt
Reading erase return status
Erase Command Succeeded

Blank Checking ............
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Reading blank check return status
Blank Check Succeeded

NOTE: In case the flash device cannot be erased, check if you are using the correct target task,
and if the hardware connection is set up correctly.

21. Perform the Programming test:

a) Different sized binary S-record files are available in the Flash Tool Kit delivery to check
whether the flash device can be programmed. The path to the S-record files is:
{CodeWarrior}\PA\PA Tools\FlashToolKit\TestSrecFiles
They are: 64k_at 0.S, 128k at 0.S, 256k _at 0.S, 1M at 0.S,
2M at 0.S,and 4M _at 0.S. For each file, the file name specifies the size of the file.

For example, file 256k _at 0.S is 256 Kilobyte sized and is linked to the 0 start-up
address.

b) Enable Program and Verify actions (Figure 21). Save the task (Ctrl + S).

Figure 21. Enable the Program and Verify Actions

Flash Devices Target FLAM
Device Name Base dddress Address: 0x | 00002000
MewFlashDevice (1Mx163x1) OxFFECOOOD Size: oy | onosooon

|:| Werify Target Memory Writes

Add Device ] [Remove Device

Flash Programmer Actions

Enabled Operation Description )
Add Action i
Erase from MNewFlashDevice ranges: {0xFFEFO000 - OxFFEFFFFF ),
Elank Check From MNewFlashDevice ranges: (0xFFEF000D - 0xFFEFFFFF), Duplicate Action
v Erase and Program file From launch configuration in MewFlashDevice using address offset 0xFFEODOOO
- i File From launch configuration in NewFlashDevice using address offsek 0xFFE000O0
Move Up

c) Double-click Program in the Operation column. The Add Program / Verify Action
dialog box appears.

d) Clear Use File from Launch Configuration check box and click File System to select a
. S file to be programmed.

e) Select the Restrict to Addresses in this Range and Apply Address Offset check boxes.
Figure 22 shows the settings.
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Figure 22. Add Program / Verify Action Dialog Box

Il Add Program / Yerify Action ll

—Flash Devices [~ Use File from Launch Configuration

Device Mame I Base Address | o -
MNewFlashDevice (1Mx16x1)  0xFFE0D000 ile: | D\ TestSrecFiles) 1M_at_0.5

File Type: I.ﬁ.uto VI Wiorkspace. .. | File System. .. | \ariables...

W Restrick to Addresses in this Range il ;‘5-

Start: O IFFEDDDDD Address: Ox IFFEDDUDD
End: 0x [ FFFFFFFF

Update Program Action | Update Yerify Action | Done |

f) Figure 22 definitions:
o Restrict to Addresses in this Range: Specifies the address range of the flash device

o Apply Address Offset: Specifies the start address, where the test data is
programmed in the flash; it should be the flash device start address.

g) Click Update Program Action.
h) Repeat steps d), e), and f) for Verify action.
i) Execute the task.

j)  Check the Console view for the algorithms used in execution of the task, as shown in
Listing 11.

Listing 11. Programming test log

Downloading 0x00002800 bytes to be programmed at OxFFEFD800
Writing Program Function Code
Writing the Address
Writing the Size
Writing the address of the buffer
Clearing the status
Setting up Registers
Commanding target to run
Programming
Reading program return status
Program Command Succeeded
log: Programmed total of 0x00100000 bytes
log:
log: Program Command Succeeded

Uploading 0x00010000 bytes starting from address OxFFEF0000
log: Uploading 0x00010000 bytes starting from address OxFFEF0000
log: Verified total of 0x00100000 bytes
log:

Verify Command Succeeded
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k) If all program/verify actions pass correctly, you have completed creation of a new flash
programming algorithm. The new flash device can be programmed with the CodeWarrior
Flash Programmer without any limitation.

7.Flash Programming Examples

7.1. Flash Programming Algorithm for AMD 16x1 Flash Devices

The AMDI16x1Example project (Figure 23) illustrates how the Flash Development Kit is used to
program AMD 16x1 flash algorithm.

Figure 23. Power Architecture CodeWarrior Projects View of AMD16x1Example Project

F[g) CodeWarrior Projects 53 =
|2 | 1% =| & &2 | File Name
File Name Size  Tvpe Build
= & AMD16x1Example : Flash Algo Relzas:
= 9!;’;. Binaries
#;32 flash_alg_debug.elf 28 KB Executable File i
@ flash_alg_release.elf 13 KB Executable File d
= = Common
D flash_algorithm, IcF ZKE CodeVWarrior Lin.,, ¥
flash_commands. b 1 KB C Header File i
flash_exit.s 1 KB Assembly Sourc,., ¥
[ Flash_main.c JKBE C Source File w
@ generic.c 1 KE C Source File v
genetic.h 1 KE C Header File i
[== Flash algo Development
== Flash algo Release
[niH Includes
= Prefix
= [= Runtime
@ __ppc_eabi_init.c Z7 KB C Source File v
@ libc_Generic_M.a 628 KB Static Library v
@ librt_Genetic_M.a 170 KB Static Library i
|=| SabnalysispointsManager. apconfig 1EB v
= = Sources
[ algo_impl.c 6 KE C Source File v

7.1.1. Implementing ID Function for AMD 16x1 Flash Devices

The sequence for getting the Manufacturer ID and Device ID, based on the AMD flash specification, is
shown in Table 5.

Table 5. ID Command Sequence for AMD Flash

Bus Cycles

Command Sequence First Second Third

(%]
©
5’ Addr | Data Addr | Data Addr | Data
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Manufacturer ID 4 555 AA

2AA

55

(BA)555 90

Device ID 6 555 AA

2AA

55

(BA)555 90

Listing 12. ID Function Sample Code for AMD Flashes

retval t ID(parameter block t *p pb)

{
volatile unsigned short *baseaddress =
retval t result = 0;

/* reset */

* (baseaddress) = (unsigned short)O0xFOFO0;
/* setup for get id */

* (baseaddress + 0x555) =
* (baseaddress + 0x2ARD)
* (baseaddress + 0x555) =

(unsigned short) 0xAA;

(unsigned short) 0x55;
(unsigned short) 0x90;

#if defined (DEBUG)
/* get id */
mf id = * (baseaddress) ;
part_id = * (baseaddress + 1);
#tendif

/* read mode again */

* (baseaddress) = (unsigned char) O0xFO;

return result;

(p_pb->base addr)

Wy

When using the Flash Algo Development build target, the device ID and manufacturer ID are read from
the flash device and stored in the part idand mf id variables (Listing 12). Check these during the

flash algorithm testing.

7.1.2.

Implementing erase_sector Function for AMD 16x1 Flash Devices

The sequence for the Sector Erase command implementation, based on the AMD flash

specification, is shown in Table 6.

Table 6. Sector Erase Command Sequence for AMD Flash

Command @ Bus Cycles

Sg ue:ce 5 First Second Third Fourth Fifth Sixth
g 5‘ Addr | Data | Addr | Data | Addr | Data | Addr | Data | Addr | Data | Addr | Data
ISEt:;tsc;r 6 555 | AA | 2AA | 55 555 | 80 555 | AA | 2AA | 55 SA 30

See the actual encoding of the erase sector function for AMD flashes in Listing 13.

Listing 13. Function erase_sector Sample Code for AMD Flashes
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retval t erase_sector (parameter block_t *p _pb, unsigned long sect_ index)
{

volatile unsigned short *sectoraddress = ((unsigned short **) (p pb-
>items) .w) [sect index];

volatile unsigned short read;

retval t result = 0;

/* reset sector */

*(sectoraddress) = (unsigned short)oxFoFo;
/* identify */

*(sectoraddress) (unsigned short)ox9090;
/* wait until results are ready */

/* check if the sector is protected */
if (* (sectoraddress+0x2)) return SECTOR_PROTECTED;

/* first of all reset the device. The fID is no longer called in the new
flash programmer plugin (it was used in the old AMC MWX-ICE) therefore
the flash chip must always be brought into the read state.

*/

/* reset sector */
* (sectoraddress) = (unsigned short)OxFOFO;

/* erase sector */

* (sectoraddress + 0x555) = (unsigned short) 0xAA;
* (sectoraddress + 0x2AA) = (unsigned short) 0x55;
* (sectoraddress + 0x555) = (unsigned short) 0x80;
* (sectoraddress + 0x555) = (unsigned short) 0xAA;
* (sectoraddress + 0x2AA) = (unsigned short) 0x55;
* (sectoraddress) = (unsigned short)0x30;

read = * (sectoraddress);

/*
Wait for the status value to be read from *addr or
how long ticks to pass. If how long ticks pass,

a non-0 value will be returned.

On the AMD chips, DQ7 is inverted until the embedded
algorithm is completed when it flips to the correct

value. The parameter 'hi' will indicate whether that
value is set or cleared.

*/

while ((read & 0x0080) != 0x0080)

{

read = * (sectoraddress);

/* read mode again */
* (sectoraddress) = (unsigned char) 0xF0;
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return result;

7.1.3. Implementing erase_chip Function for AMD 16x1 Flash Devices

The sequence for the Chip Erase command, based on the AMD flash specification, is shown in Table
9. The Common Flash Interface commands are shown in Table 8Table 8 and Table 9. See the actual
encoding of the erase chip function for AMD flashes in the algo impl. c file as shown in

Listing 14.

Table 7. CFI Query Identification String Sequence for AMD Flash

Word Address Data Description
(SA) + 0010h 0051h
(SA) + 0011h 0052h Query Unique ASCII string “QRY”
(SA) +0012h 0059h

Table 8. CFI Device Geometry Definition for Regions Sequence for AMD Flash

(SA) + 002Dh 00XXh Erase Block Region 1 Information (refer to JEDEC JESD68-01 or JEP137 specifications)
(SA) + 002Eh 000Xh 00FFh, 0003h, 0000h, 0002h =1 Gb
00FFh, 0001h, 0000h, 0002h = 512 Mb
(SA) + 002Fh 0000h 00FFh, 0000h, 0000h, 0002h = 256 Mb
(SA) + 0030h 000Xh 007Fh, 0000h, 0000h, 0002h = 128 Mb
(SA) +0031h 0000h
(SA) + 0032h 0000h y ) 8
Erase Block Region 2 Information (refer to CFl publication 100)
(SA) + 0033h 0000h
(SA) + 0034h 0000h
(SA) + 0035h 0000h
(SA) + 0036h 0000h : . ;
Erase Block Region 3 Information (refer to CFI publication 100)
(SA) +0037h 0000h
(SA) +0038h 0000h
(SA) + 003gh 0000h
(SA) + 003Ah 0000h . ) o
Erase Block Region 4 Information (refer to CFl publication 100)
(SA) + 003Bh 0000h
(SA) + 003Ch 0000h

Table 9. Chip Erase Command Sequence for AMD Flash

C d a Bus Cycles

Sgnrjn;r?ge 9 First Second Third Fourth Fifth Sixth
q 5” Addr | Data | Addr Data | Addr Data | Addr Data | Addr Data | Addr Data
Ecizlspe 6 555 AA 2AA 55 555 80 555 AA 2AA 55 555 10

Listing 14. Function erase_chip encoding for AMD flashes
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retval t erase_chip (parameter block t *p_ pb)
{
int errors = 0;
retval t result = 0;
unsigned short stat;
unsigned short mask = (unsigned short)DQ7;
unsigned short masked src = (unsigned short)DQ7;
int got it;
volatile unsigned short *base addr = (p_pb->base addr) .w;

/* reset sector */

*(base_addr) = (unsigned short)oxFoFe;
/* identify */

*(base_addr) = (unsigned short)0x9090;
/* wait until results are ready */

*(base_addr) = (unsigned short)oxFoFe;
/* CFI Entry command */
*( (unsigned short *)base_addr + ©x55 ) = 0x0098; /* write CFI entry command */

/*
* if the chip supports Common Flash Interface, then it answers with the Query Unique
ASCII string “QRY”
* (Ox51, ©x52, 0x59) after it receives the CFI entry command; you can read these
answers at
* the next offsets: 0x10, 0x11, ox12

*/
/*

* get the sector size and count of every four regions
* address data description

* 2Dh 00xxh Erase Block Region 1 Information

* 2Eh 000xh ©OFFh, ©0003h, 0000h, 0002h = 1 Gb

* 2Fh 0000h 0OFFh, 0001h, ©000h, 0002h = 512 Mb
* 30h 000xh ©OFFh, ©000h, ©000h, 0002h = 256 Mb
* ©07Fh, 0000h, 0000h, 0002h = 128 Mb

* 31h Erase Block Region 2 Information

* 32h Refer to CFI publication 100

* 33h

* 34h

* 35h Erase Block Region 3 Information

* 36h Refer to CFI publication 100

* 37h

* 38h

* 39h Erase Block Region 4 Information

* 3Ah Refer to CFI publication 100

* 3Bh

* 3Ch

*/

/* CFI Exit command */
*( (unsigned short *)base_addr + 0x000 ) = Ox00FQ; /* write cfi exit command */
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/* reset sector */

*(base_addr) = (unsigned short)oxFoFo;
/* identify */

*(base_addr) = (unsigned short)0x9090;
/* wait until results are ready */

/*
* you can find the total number of sectors and then for every sector you can check
* the value from the address *(sectoraddress + ©x2) to see if that sector is protected

*/

/* first of all reset the device. The fID is no longer called in the new
flash programmer plugin (it was used in the old AMC MWX-ICE) therefore
the flash chip must always be brought into the read state.

*/

*base addr = 0xFOFO;

/* erase sector */

* (base addr + 0x555) = (unsigned short) OxAA;
* (base_addr + O0x2AA) = (unsigned short) 0x55;
* (base addr + 0x555) = (unsigned short) 0x80;

/* erase chip */

* (base addr + 0x555) = (unsigned short) OxAA;
* (base_addr + O0x2AA) = (unsigned short) 0x55;
* (base addr + 0x555) = (unsigned short)0x10;

/* Wait for status operation */

mask &= 0x0080; /* Only dg7 flips */
masked src &= 0x0080;
while ( 1 )
{
if ( (*base addr & mask) == masked src )
{
break;

/* return to read mode */
*base addr = 0xf0;

return result;

7.1.4. Implementing write Function for AMD 16x1 Flash Devices

In terms of AMD flash devices specification, the write function realizes the Program command. The
sequence for the Program command, according to the AMD specification, is shown in Table 1010.
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Table 10. Program Command Sequence for AMD Flash

@ Bus Cycles
Command Sequence 5 First Second Third

5‘ Addr Data Addr Data Addr Data
Program 4 555 AA 2AA 55 555 A0

The sequence for Common Flash Interface commands are shown in Table 8 ana Table 9. They are used
to check if any of the sectors involved in the writing process are protected before actualy writing the

data.

See the actual encoding of the write function for AMD flashes in the algo impl. c file as shown in

Listing 15.
Listing 15. Sample write Function Code for AMD Flashes

retval t write(parameter block t *p pb)
{
int timed out, got it;
unsigned long i;
unsigned short stat;
retval t errors = 0;
unsigned short mask = (unsigned short)DQ7;
unsigned short masked src = (unsigned short)DQ7;
(p_pb->base addr)

(p_pb->items) .w;

volatile unsigned short *base addr = WS
unsigned short *buffer =
unsigned long buffer len = p pb->num items;
unsigned long how many = buffer len / sizeof (unsigned short);
/* reset sector */

* (base _addr) = (unsigned short)O0xFOFO0;

/* identify */

* (base _addr) = (unsigned short)0x9%9090;

/* wait until results are ready */

* (base _addr) = (unsigned short)O0xFOFO;
/* CFI Entry command */

*( (unsigned short *)base addr align + 0x55 ) = 0x0098;
/*
* Add code:
Unique ASCII

if the chip supports Common Flash Interface,

/* write CFI entry command */

then it answers with the Query

* string QRY (0x51, 0x52, 0x59) after it receives the CFI entry command; you can read
these answers at

* the next offsets: 0x10, O0x11, 0x12

*/

/*

* Add code: get the sector size and count of every four regions

* address data description

* 2Dh 00xxh Erase Block Region 1 Information
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* 2Eh 000xh OOFFh, 0003h, 0000h, 0002h = 1 Gb
* 2Fh 0000h OOFFh, 0001h, 0000h, 0002h = 512 Mb
* 30h 000xh OOFFh, 0000h, 0000h, 0002h = 256 Mb
* 007Fh, 0000h, 0000h, 0002h = 128 Mb
* 31lh Erase Block Region 2 Information
* 32h Refer to CFI publication 100
* 33h
* 34h
* 35h Erase Block Region 3 Information
* 36h Refer to CFI publication 100
* 37h
* 38h
* 3%h Erase Block Region 4 Information
* 3Ah Refer to CFI publication 100
* 3Bh
* 3Ch
*/
/* CFI Exit command */

*(

/* reset sector */
* (base addr) =
/* identify */
* (base addr) =

(unsigned short *)base addr align + 0x000 ) =

0x00F0; /* write cfi exit command */

(unsigned short) OxFOFO;

(unsigned short)0x9090;

/* wait until results are ready */

/*
* Add code:
*/

if ( buffer len %

you can iterate through each sector that is involved in the writing process
* and check the address * (base addr + 0x2)

to see if that sector is protected

sizeof (unsigned short) ) ({
/* we need to fill the remaining bytes with 'ff'

-- this assumes

byte accesses to DRAM will work */

char *p =
*p++ = "\xff';
how_many++ ;

/* first of all reset the device.
flash programmer plugin

(it was used in the old AMC MWX-ICE)

(char *) ((unsigned long)buffer + buffer len);

The fID is no longer called in the new
therefore

the flash chip must always be brought into the read state.

*/
*base addr =
for

(i = 0;

unsigned short *c

*((c) + 0x555)
*((c) + Ox2aa)
*((c) + 0x555)

(1 < how_many)

&&

lerrors;

(unsigned short)O0xf0f0;

1i++4) {

= (unsigned short*) ((unsigned long)base addr & ~Ox1fff);

Oxaa;
0x55;
0xal;
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*base addr = *buffer;
/* Wait for status operation */

mask &= 0x0080; /* Only dq7 flips */
masked src = (unsigned short) ( (unsigned char)DQ7 & *buffer);
masked src &= 0x0080;
while ( 1 )
{

if ( (*base_addr & mask) == masked src )

{

break;

}
}

base addr++;
buffer++;
}

/* go back to the last access */
--base addr;

/* read mode again */
*base addr = (unsigned char) 0xf0;

return errors;

7.2. Flash Programming Algorithm for NAND eLBC - K9F5608x0D

The Algorithm and the Utility for this NAND device can be found in NAND Example folder and were
made for eLBC controller and P1020RDB board. Both the algorithm and the utility were implemented in
the same project, because the Utility is not common for NAND devices and is specific for each device.
This project is formed of three parts and the user must complete only the files from Sources folder.

NOTE When you update this algorithm for another board, ensure to update the eLBC.h file (it is
very important to have eLBC_OFFSET updated with the processor reference manual and
IMMR_BASE updated with the initialization file settings).

7.3. Flash Programming Algorithm for NAND IFC — K9F5608x0D

The algorithm and utility for this NAND device can be found in NAND IFC Example folder and were
made for IFC controller and P1010RDB board. Both the algorithm and the utility were implemented in
the same project, because the utility is not common for NAND devices and is specific for each device.
This project is formed of three parts and the user must complete only the files from Sources folder.
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NOTE When you update this algorithm for another board, ensure to update the ifc.h file (it is
very important to have the IFC_ NAND OFFSET updated with the processor reference
manual and CCSRBAR updated with the initialization file settings).

7.4. Flash Programming Algorithm for SPI — S25FL128P

The algorithm and utility for this SPI device can be found in SPI Example folder and were made for
eSPI controller and P1024RDB board. Both the algorithm and the utility were implemented in the same
project, because the utility is not common for SPI devices and is specific for each device.

This project is formed of three parts and the user must complete only the files from Sources folder.

NOTE When you update this algorithm for another board, Ensure to update the device defs.h
file (it is very important to have the ESPIBASE updated with the processor reference
manual and initialization file settings—this is a sum between CCSRBAR and eSPI
register group address).

8. Creating a New Flash Utility

Some flash devices, such as NAND and SPI are not memory mapped. The memory cannot be read
directly; therefore, a special utility is needed for blank check and checksum operations. This is very
similar to a flash algorithm. It receives the commands through a data structure and passes back the
results through the same structure.

8.1. Flash Utility Template Overview

The Flash Utility Template described in this document also helps you develop flash utilities for the
CodeWarrior Flash Programmer, as shown in Figure 24. This section provides important information
needed before you begin creating a flash utility.
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Figure 24. Flash Utility

@ Code'Warrior Projecks  £3

:.: % = 5134,',3 File: Marne

File: Mame Size | Type Build
# == AMD16x1Example : Flash Algo Releas:
# (=% FlashToolkitTemplate : Flash Algo Dev
# (=% FlashUtilityExample : Flash Likility Deve
= & FlashUtilityTemplate @ Flash Utility Dey

= :_i:;. Binaries
+ ﬁflash_utility_debug.elf Z0KE Executable File v
+ @ flash_utility_release.elf 12 KB Executable File v
= == Cammon
=] Flash_algorithr.lcf 2 KB CodeVwarrior Lin.., ¥
+ flash_exit.s 1KE Assembly Sourc,,, ¥
Common pﬂl't + FlashUkility b Z KB C Header File v
+ genetic.h 1KE C Header Filz v
+ || ukility_rnain.c 2 KB C Source File v
4 [~ Flash Utility Development
4 = Flash Utility Release
# [n) Inchudes
4 = Prefix
+ = Runtime
SafnalysispointsManaget, apconfig 1KE v

=l [ Sources
User part 4[ g ukility_impl.c 1KE (C Source File v J

8.2. Flash Utility General Structure

The Flash Utility application is divided into three different sets of files:

1. Flash Utility Common Files (No Modification Needed): Contains initialization and other files.
This component is common for all flash devices and you should not change it while developing
the new flash programming algorithm. It consists of the following files:

o flash algorithm.lcf file: Linker command file, which is set up according to the rules
for flash programming applet allocation in physical memory.

o utility main.c: Main function and API to the CodeWarrior Flash Utility.

o FlashUtility.h: Header file with the generic data structures and definitions used by flash
utilities.
o flash exist.s: Exitpoint for the flash programming applet.

o generic.h: Header file that contains general data structures and definitions used by all flash
programming algorithms.

2. User Files (Implement Utility): Contains flash device specific files. This component is modified
for any flash devices depending on the flash utility to be used. It consists of the following files:

o Utility impl.c: Includes functions to implement for the flash device utility, such as
executeBlankCheck and executeCheckSum.
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3. Run-Time Files :

o ppc eabi init.c: Includes flash programmer start-up initialization file.

To create a new utility for flash programming, make changes only to the utility impl.c file.

8.3. Flash Utility Build Targets

Several build targets are predefined in the Flash Utility Template:

» Flash Utility Development: Flash utility development and test application. The ELF executable
file, created in Flash Utility Development, should be used to develop, debug, and test the new
CodeWarrior Flash Programmer utility.

» Flash Utility Release: To create flash utility applet, the CodeWarrior Flash Programmer uses the
ELF executable file, created in Flash Utility Release. This build target shares the flash device
utility with the Flash Utility Development build target; it differs, however, because it cannot be
debugged or tested (Figure 25).

Figure 25. Flash Utility Targets

C/C+ + Build -

#- Resource
Builders
- CfC++ Build Build configuration: | Flash Ukility Development [ Active ] e
#- CfC++ General Flash Litility Development [ Active
Project References Flash Utility Release

; All configurations ]
Refactoring Histary = r ) [ =

=| Builder Settings | (&)
RunDebug Settings & = %) Behaviour

EBuilder
Builder type: External builder »
Use default buid command

Build command:

IMakefile generation
Generate Makefiles automatically

Build location
Build directary: | $4ProjDirPath}jFlash Utility Development

Workspace. .. ] [F\Ie system... ] [Variahles...

Restare Defaults ] [ Apply

8.4. Flash Utility API

The CodeWarrior Flash Programmer communicates with the flash utility applet through two different
commands:

e Blank Check

* Checksum
The same memory zone defined for Flash Device Algorithm, the parameterBlockType structure, is
used by the utility.
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On the flash utility side, the commands from the CodeWarrior Flash Programmer go through the
parameterBlockType structure, and are mapped in the memory, from the beginning of the memory
buffer.

All commands from the CodeWarrior Flash Programmer are already encoded in utility main.c
file. This file can be used for the new flash programming algorithm without any modification. After
loading the utility applet to the target board, the CodeWarrior Flash Programmer writes all parameters
right in the data structure located at the beginning of the memory buffer.

For the detailed description of the parameterBlockType structure, see Listing 16.

Listing 16. parameterBlockType Structure Details

typedef volatile struct {

unsigned long magicNumber; /* Magic id code used to verify image */

unsigned long function; /* What function to perform ? */

unsigned long result status; /* Status of the operation */

pointer type start_address; /* start address of the operation */

pointer type end address; /* end address of the operation */

unsigned long numBlankCheckErrors; /* total number of blank check errors found */

unsigned long numRecordedBlankCheckErrors; /* number of mismatches recorded

*/

mismatchErrorType *mismatches; /* address of the array of mismatches*/

unsigned long checksumvValue; /* intput and output checksum value */

unsigned long baseAddress; /* Base address of the flash */

unsigned long ccsrbar; /* Base address for memory mapped registers */

unsigned long core_type; /* Core Type - used for handle between different processor FP
controller structs */

unsigned long controller offset; /* Controller Offset */

unsigned long controller type; /* Controller Type */

unsigned long additionalParameterNum; /* Number of additional parameters sent by FP
Plugin */

unsigned long additionalParameterStart; /* First additional parameter */

unsigned long padding([7]; /* Padding for other additional parameters */ }
parameterBlockType;

Listing 16 definitions:

e magicNumber: Indicates a number written at the beginning of the flash utility parameter block.
The CodeWarrior Flash Programmer reads the first location from the memory buffer upon
downloading the utility. The expected value is 0xBCC5BCC5.

e function: Specifies the command to be executed. It can be blank check or checksum.

e result status: Contains the operation result. It can be success, fail, or unknown command.
e start address: Specifies the start address for the requested command.

e end address: Specifies the end address for the requested command.

e numBlankCheckErrors: Stores the number of errors found during the blank check operation.

e numRecordedBlankCheckErrors: Indicates the number of errors that have been recorded
during blank check. Up to 12 errors are recorded.
Adding Device(s) to the CodeWarrior™ Flash Programmer for Power Architecture™ Processors
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mismatches: Indicates a pointer to the mi smatchErrorType structure defined in Listing 17.
It contains all errors recorded.

checksumValue: Specifies the checksum computed.

baseAddress: Specifies the base address of the flash.

ccsrbar: Specifies Is the base address for memory mapped registers.

core type: Helps to handle between different processor Flash Programmer controller structures.
controller offset: Indicates the controller offset.

controller_type: Gives the controller type.

additionalParameterNum: Indicates the number of additional parameters sent by Flash
Programmer Plugin.

additionalParameterStart: Specifies the first additional parameter.
padding[7]: Is reserved for other additional parameters.

Listing 17. mismatchErrorType Structure Details

typedef volatile struct {
pointer type address; /* where the error/mismatch occured */
unsigned long expected;
unsigned long actual;

} mismatchErrorType

Listing 17 definitions:

address: Represents a structure of pointer type defined in Listing 18. It contains the
address where an error has been found.

expected: Indicates the value expected to be found in flash memory.

actual: Indicates the value actually found in flash memory.

Listing 18. pointer_type Structure Details

typedef union {unsigned char* c;
unsigned short* w;
unsigned long* 1;

unsigned long long* 11;
void* e;} pointer type;

The pointer type isasomewhat generic pointer. We can use this pointer to get any data type—
unsigned char, short, long, long long, or void.

The supported functions are:

BlankCheck

The BlankCheck command is called by the flash programmer to blank check a memory
range. For the BlankCheck command, the CodeWarrior Flash Programmer:
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e Loads the flash utility on the target board
e Sets the BlankCheck command as shown in the function field of Listing 16

e Setsthe start address and end address parameters as shown in the function
field of Listing 16

e Runs the flash utility applet
e Waits until flash utility stops execution

e Checks the status of the command being executed as shown in result status from
Listing 16

e Reads the number of errors and records the errors and their location if the status reports
an error, as shown in Listing 16

Checksum

The Checksum command is called by the flash programmer to blank check a memory range.
For the Checksum command, the CodeWarrior Flash Programmer:

e Loads the flash utility on the target board
e Sets the Checksum command as shown in the function field of Listing 16

e Setsthe start address and end address parameters as shown in the function
field of Listing 16

e Runs the flash utility applet
e Waits until flash utility stops execution

e Checks the status of the command being executed as shown in result status from
Listing 16
e Reads the checksum result if status is success, as shown in Listing 16

8.5. Create New Flash Utility

To create a new CodeWarrior Flash Programmer flash utility using the Flash Utility Template, for a
flash device not supported by the CodeWarrior software:

1. Store the original version of Flash Utility Template available in the CodeWarrior delivery to a
different working directory. The location of the FlashUtilityTemplate folder is:
{CodeWarrior} \PA\PA Tools\FlashToolKit\FlashUtilityTemplate

2. Import Flash Utility Template project:
a) Select File=>Import from the IDE menu bar. The Import dialog box appears.

b) Select General->Existing Projects into Workspace. Click Next. The Import Projects
page appears.

c) Click Browse to choose the parent folder where you have copied the
FlashUtilityTemplate folder, select the folder, and click OK. The Projects list
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gets populated with the projects available in the FlashUtilityTemplate folder.

d) Clear the check boxes next to the projects that you do not want to import and click
Finish. The imported project is displayed in the CodeWarrior Projects view in the
C/C++ perspective, as shown in Figure 24.

e) Ensure that the Flash Utility Development build target is selected.
Select Run>Debug Configurations. The Debug Configurations dialog box appears.
Expand the CodeWarrior Download tree node and select the desired launch configuration.
Click the Debugger tab in the right panel.
Select the required target processor from the Target Processor drop-down list.

Specify required target initialization and memory configuration files for the connected hardware
in the Target initialization file and Memory Configuration File text boxes. For supported
Freescale Evaluation Boards, you can use the debugger config files (*.tcl), and the debugger
mem files (*.mem) available with the CodeWarrior Development Studio. Check the folder:
{CodeWarrior} \PA\PA Support\Initialization Files.

Modify executeBlankCheck function fromutility impl.c file. The function must
read the command options, perform the blank check and put the results in parameter block. See
Modify ID function in the algo_impl.c file: for an implementation example.

Modify executeCheckSum function from utility impl. c file. The function must read
the command options, perform the checksum, and put the results back in parameter block. See
Modify ID function in the algo_impl.c file: for an implementation example.

Compile Flash Utility Development target. While creating and testing a new utility, use the Flash
Utility Development build target of the Flash Utility Template project. Compilation will result in
creation of anew flash utility debug.elf file.

. Flash utility unit testing:

a) To test a flash utility algorithm, define custom flash device parameters in
utility main.c. You can select the operation you want to perform and the address
in flash to which the operation will be applied.

b) Loadthe FlashUtilityTemplateDebug.elf file and run it on a target board.
Check the tests results. As an example of the test working, see Modify ID function in the

algo_impl.c file:

Compile Flash Utility Release target. Copy the resulted file in the following folder
{CodeWarior}\PA\bin\plugins\support\Flash Programmer\EPPC

Use the new Flash Utility in the device description XML file. Run a Flash Programmer with the
new device / utility as described for the flash algorithm in Create a New Flash Programming

Algorithm.
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9. Flash Utility Examples

9.1. Flash Utility Example for NOR Flash Devices
The FlashUtilityExample project (Figure 26) implements a flash utility for the NOR flash devices.

Figure 26. FlashUtilityExample Project
) Codetwarrior Projects 52 = B8

|g| laz | = é"" ﬁ | File: Marmne =

File Mame Size  Twpe Bild
== AMD16x1Example © Flash algo Releas:
=% FlashToolkitTemplate : Flash Algo Dev

¥ FlashUkilityExample : Flash Utilicy Deve

= 35, Binaties
#ﬁl Flash_utility_debug.elf 21 KB Executable File 4
i} Flash_utility_release.elf 12 KB Executable File V
= = Common
flash_algorithm.|cf 2KB CodeWarriorLin,,, ¥
EI flash_exit.s 1KB #ssembly Sourc,,, ¥
@ FlashUkility . b 2 KB C Header File v
[h] generic.h 1KE C Header File v
[£] utility_main.c 2KE C Source File v
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= = Sources
[£] wtility _impl.c 4KB  Source File v

9.1.1. Implementing executeBlankCheck Function

Listing 19 shows the implementation of the function.

Listing 19. Implementation of executeBlankCheck Function

void executeBlankCheck ()

{
unsigned char *endAddress;
unsigned char *currentAddress;
unsigned longrecordedMismatches;
unsigned long totalMismatches;

// Retrieve the operating bounds from the parameter block
currentAddress = gParams.start address.c;

Adding Device(s) to the CodeWarrior™ Flash Programmer for Power Architecture™ Processors
60 Freescale Semiconductor




4
Flash Utility Examples

endAddress = gParams.end address.c;

recordedMismatches = 0;
totalMismatches = 0;

while ( currentAddress <= endAddress )

{
if ( *currentAddress != FLASH UTILITY ERASED VALUE )
{

totalMismatches++;

if ( recordedMismatches < FLASH UTILITY MAX MISMATCH ERRORS )
{

gMismatches|[recordedMismatches] .address.c = currentAddress;
gMismatches[recordedMismatches] .expected =

FLASH UTILITY ERASED VALUE;
gMismatches[recordedMismatches] .actual = *currentAddress;

recordedMismatches++;

// ensure we don't have a problem getting out of the
// loop at OxFFFFFFFF

if ( currentAddress == endAddress )
break;
currentAddress++;

// Update the output parameters for the flash programmer to read
if ( totalMismatches != 0 )
gParams.result status =
FLASH UTILITY STATUS BLANKCHECK FAIL;
}

else

gParams.result status

FLASH UTILITY STATUS SUCCESS;

gParams.numBlankCheckErrors

totalMismatches;
gParams.numRecordedBlankCheckErrors

recordedMismatches;

The function reads from start address to end address and compares all memory values with
the erased memory values. The errors equal to the value of the parameter

FLASH UTILITY MAX MISMATCH ERRORS are stored and returned through the parameter block
structure.
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9.1.2. Implementing executeCheckSum Function

Listing 20 contains the implementation of the function.

Listing 20. Implementation of executeCheckSum Function

vold executeCheckSum ()

{
unsigned char *endAddress;
unsigned char *currentAddress;
unsigned long checksumValue;

// Retrieve the operating bounds from the parameter block

currentAddress = gParams.start address.c;
endAddress = gParams.end address.c;
checksumValue = gParams.checksumValue;

while ( currentAddress <= endAddress )

{

checksumValue += *currentAddress;

if ( currentAddress == endAddress )
break;
currentAddress++;

// Update the output parameters
gParams.checksumValue = checksumValue;

// Update the output status
gbParams.result status = FLASH UTILITY STATUS SUCCESS;

The function computes the checksum between start address and end address, and then returns
the result through the parameter block structure.

10. Troubleshooting the Flash Programmer

It is possible that the CodeWarrior™ Flash Programmer does not recognize the flash devices on your

target, or has a problem with erasing or programming. If so, use the troubleshooting techniques in this
topic to ensure that basic reads and writes to flash function correctly. If you still cannot program your
flash devices, contact Technical Support at:

http://www.freescale.com/support.

This topic explains how to configure your target flash devices to display their manufacturer and device
ID codes. If the devices can display this information, then basic reads and writes to the devices are
functioning correctly. This means that you are unable to program your flash due to either:
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* The flash device configuration file

¢ The flash-programming algorithm

10.1. Theory

Current flash devices use a common method for preventing unintentional programming. A specific
sequence of write cycles must precede each flash programming write cycle, to enable programming of
one byte (8 bits) or word (16 bits). These preceding write cycles walk through an internal-state machine
that enables the flash for one device-programming write cycle. This write-enabling process is necessary
for each flash address to be programmed.

You can use the same method to configure a flash device to display its manufacturer and device ID
codes:

¢ The manufacturer ID code is the same for all devices from each manufacturer. Common codes are
0x01 for AMD, 0x1F for Atmel, and 0x89 for Intel.

¢ Device ID code is unique for each device; each device’s data sheet specifies its ID code.

Reading these ID codes requires successful write and read cycles to each flash device. This indicates that
the flash-programming problems exist in the CodeWarrior Flash Programmer rather than in the target
hardware. Similarly, inability to read these ID codes indicates a low-level problem with reading/writing
target flash. You must resolve such hardware problems for the flash programmer to work.

10.2. Practice

The explanation of this document involves using the CodeWarrior debugger and its Command Line
panel to write to and to read from target flash. Before you begin, you must be running a debug session to
the target.

The process uses the CodeWarrior commands, change, which writes to memory, and display, which
reads from memory. The general formats are:

change p:<address><value><bus-width>
display p:<start address>..<end address><bus-width>

where:

* <address>, <start address>, and <end address> are address values that comply
with the CodeWarrior default radix, or with an explicitly defined radix.

* <value>is adata value that complies with the CodeWarrior default radix, or with an explicitly
defined radix.

* <bus_ width>is 8bit, 16bit, 32bit, or 64bit.
These commands are used to push flash commands to the devices on your target and then to read the

data that the flash presents. All flash devices use a flash-command state machine to process commands,
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such as ReadDevice ID, Erase Sector, and Program. See the data sheet for details of the device command
sequences.

This section presents common command sets for reading manufacturer and device IDs. To use any of
these examples, you must change the strings %%% to the high-order starting address of the flash on your
target. For example, if the flash base address is 0xffe00000, your replacement string for %%% is ffe.
The data values in these examples must remain as listed.

To use these command sets:

Enter each of the change and display commands exactly as listed, except for substituting the
correct high-order address string for %%%.

Examine the information you obtain from the display command for the ID codes defined in the
data sheet for your flash device.

If the manufacturer of your target flash device is not AMD, Atmel, or Intel, then compare the command
sequences of your devices with the command sequences of the devices manufactured by AMD, Atmel,
and Intel. Most likely, your device uses the command sequence of one of these device manufacturers.
Fujitsu flash devices, for example, use the same commands as AMD devices. Sharp flash devices use the
same commands as Intel devices. And even if your flash device does not use exactly the AMD, Atmel,
or Intel command sequence, the command sequence should be nearly similar. You can, therefore, easily
adapt the command sequences of other device manufacturers.

10.3. Using the CodeWarrior Script Files

The CodeWarrior source command reads the contents of a text file as a list of sequential CodeWarrior
commands. Accordingly, you may copy the contents of any listing, below, to a text file with extension
.tcl. Then, use the source command to invoke the script. See examples 1 and 2 for more information.

10.4. Before You Start

Before you can start diagnosing flash problems, gather as much of this information as possible:

Device manufacturer, such as AMD, Atmel, or Intel
Device part number

Number of devices on your target

Number of data bits (8 or 16) each flash device uses

Starting flash address on the target

NOTE You can also troubleshoot your flash device without the information listed above.
However, that would increase your efforts. The instructions below are consistent with
you having all this information.

To ensure that your ID-value interrogation does not fail:
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Writes to flash and reads from flash must occur exactly as the manufacturer defines for reading
out the manufacturer and device ID codes. Ensure that you disable all address-translation and
memory management features.

Disable all processor caches. (You must write to/read from the actual flash devices, not a cached
copy of flash.)

Check the target schematic, to ensure that each WE# (write-enable) processor signal reaches the
correct WE# pin of each target flash device. The target hardware, the target-processor
configuration, or both, can disable the WE# signal.

Check the memory-control registers of the target processor, to ensure that flash accesses are not
read-only.

For a 16-bit flash device, determine whether the processor’s least-significant address line is
connected to the flash device. If so, you can rely on the addresses of the flash data sheet. An
example is the AMD AM29LV640D/AM29LV641D data sheet, which specifies this sequence
for reading device and manufacturer ID codes:
%0555 = AA
$302AA = 55

%%%0555 = 90
But many processors do not have the least-significant address line connected to the flash device,
as there is no reason to address individual bytes. If this is the arrangement for your target, you
must compensate by shifting data sheet addresses left by one. This would change the sequence
above to:

oo oo
oo oo

Q
Q

AAA = AA
554 = 55
0AAA = 90

oo oo oo
oo oo oo
oo oo oo

S O

Confirm that data bus least significant bit of each flash device connects to the least significant bit
of the processor. The CodeWarrior Flash Programmer does not support reverse wired flash
devices.

10.4.1. AMD Devices

Some AMD devices are dual-mode, supporting either 8 bit or 16 bit modes. To determine the mode,
check the state of the flash BYTE pin: BYTE = 0 means 8 bit mode configuration; BYTE = 1 means 16
bit mode configuration.

Listing 21 through Listing 29 provides command sequences for AMD flash devices.

10.4.2. Atmel Devices
Listing 30 through Listing 35 provides command sequences for Atmel flash devices.
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10.4.3. Intel Devices

Listing 36 through Listing 41 provides command sequences for Intel flash devices. The status register
read outs of these listings is not required for reading out the ID codes. However, if you enter these
commands correctly, the status register results show an operation successful status or possible chip
errors.

Some Intel devices are dual-mode, supporting either 8 bit or 16 bit modes. To determine the mode,
check the state of the flash BYTE# pin: BY TE# = 0 means 8 bit mode configuration; BY TE# = 1 means
16 bit mode configuration.

10.5. Procedure

Perform these steps:
1. Start a CodeWarrior debugging session for your target.
2. Identify the appropriate command sequence for your device using Table 9.
a) If your manufacturer is Fujitsu, use the AMD listing for your arrangement.
b) If your manufacturer is Sharp, use the Intel listing for your arrangement.

c) Otherwise, find the closest match for your device arrangement, so that you can modify the
command sequence explained in Step 3.

3. Substitute the high order address string with %%% in the code of the selected listing and perform
either of the following:

a) Enter the listing commands one after another, in the Debugger Shell view, or

b) Copy the commands, paste them into a .tcl text file, then use a source command in the
Debugger Shell view to invoke the new script.

4. In the output of the display command, look for the ID codes of your flash device. The device’s
data sheet specifies these code values.

a) If the output includes the ID codes, you have confirmed that flash device basic reads and
writes function properly. This means that any programming problem lies with the
CodeWarrior software, so you should report the matter to Freescale Technical Support:
www.freescale.com/support.

b) If the output does not include the ID codes, you have confirmed a low-level problem with
reading from or writing to your flash devices. You must solve this problem locally for the
CodeWarrior Flash Programmer to work.

Two examples follow the command sequence listings.

10.6. Command Sequence Listings

Table 9 lists various flash device arrangements and the corresponding command sequences.
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Table 11. Flash Device Command Sequences

Manufacturer Devices See

One 8-bit device Listing 21

One 8-bit/16-bit device, in 8-bit mode Listing 22

Two 8-bit devices Listing 23

Two 8-bit/16-bit devices, in 8-bit mode Listing 24

AMD Four 8-bit devices Listing 25
Four 8-bit/16-bit devices, in 8-bit mode Listing 26

One 16-bit device Listing 27

Two 16-bit devices Listing 28

Four 16-bit devices Listing 29

One 8-bit device Listing 30

Two 8-bit devices Listing 31

Atmel Four 8bit devices Listing 32
One 16-bit device Listing 33

Two 16-bit devices Listing 34

Four 16-bit devices Listing 35

One 8-hit device Listing 36

Two 8-bit devices Listing 37

Four 8-bit devices Listing 38

intel One 16-bit device Listing 39
Two 16-bit devices Listing 40

Four 16-bit devices Listing 41

Listing 21. AMD: One 8-bit Device

# Set device to Read state
change p:%%%00000 f0 8bit

# Get Mfg and Device ID values

change p:%%%00555 aa 8bit
change p:%%%002aa 55 8bit
change p:%%%00555 90 8bit

# Display Mfg ID value at offset
0# Display Dev ID value at offset 1
display p:%%%00000..%%%00002 8bit

# Reset device to Read state
change p:%%%00000 £f0 8bit

Listing 22. AMD: One 8-bit/16-bit Device, in 8-bit Mode
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# Set device to Read state
change p:%%%00000 f0 8bit

# Get Mfg and Device ID values
change p:%%%00aaa aa 8bit
change p:%%%00555 55 8bit
change p:%%%00aaa 90 8bit
# Display Mfg ID value at offset 0
# Display Dev ID value at offset 1
display p:%%%00000..%%%00002 8bit

# Reset device to Read state
change p:%%%00000 f0 8bit

Listing 23. AMD: Two 8-bit Devices

# Set devices to Read state
change p:%%%00000 f0f0 1é6bit

# Get Mfg and Device ID values
change p:%%%00aaa aaaa 16bit
00554 5555 16bit

0Oaaa 9090 1lébit

change p:%%%
change p:%%%
# Display Mfg ID values at offsets 0, 1
# Display Dev ID values at offsets 2, 3
display p:%%%00000..%%%00004 8bit

# Reset devices to Read state
change p:%%%00000 f0f0 1lébit

Listing 24. AMD: Two 8-bit/16-bit Devices, in 8-bit Mode

# Set devices to Read state
change p:%%%00000 f0f0 lébit

# Get Mfg and Device ID values
p:%%%001554 aaaa lobit

change p:%%%00aa8 5555 1l6bit
p:%%%01554 9090 1leébit

change

o
°
o
°

change

# Display Mfg ID values at offsets 0, 1
# Display Dev ID values at offsets 2, 3
display p:%%%00000..%%%00004 8bit

# Reset devices to Read state
change p:%%%00000 f0f0 16bit
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Listing 25. AMD: Four 8-bit Devices

# Set devices to Read state
change p:%%%00000 f0f0f0f0 32bit

# Get Mfg and Device ID values

000

change p:%%%01554 aaaaaaaa 32bit
$00aa8 55555555 32bit

change p:%%%
$01554 90909090 32bit

o
°
o
°

o° oo

change p:

# Display Mfg ID values at offsets 0, 1, 2,
# Display Dev ID values at offsets 4, 5, 6, 7
display p:%%%00000..%%%00008 8bit

# Reset devices to Read state
change p:%%%00000 fO0f0f0f0 32bit

Listing 26. AMD: Four 8-bit/16-bit Devices, in 8-bit Mode

# Set devices to Read state

change p:%%%00000 f0f0f0f0 32bit

# Get Mfg and Device ID values

change p:%%%02aa8 aaaaaaaa 32bit

change p:%%%01550 55555555 32bit

change p:%%%02aa8 90909090 32bit

# Display Mfg ID values at offsets 0, 1, 2, 3
# Display Dev ID values at offsets 4, 5, 6, 7
display p:%$%%00000..%%%00008 8bit

# Reset devices to Read state

change p:%%%00000 fO0f0f0f0 32bit

Listing 27. AMD: One 16-bit Device

# Set device to Read state
change p:%$%%00000 f0f0 lébit

# Get Mfg and Device ID values
change p:%%%00aaa aaaa l6bit
00554 5555 16bit

0Oaaa 9090 1lebit

change p:%%%
change p:%%%
# Display Mfg ID value at offset O
# Display Dev ID value at offset 2

display p:%%%00000..%%%00004 16bit

# Reset device to Read state
change p:%%%00000 f0f0 1l6bit

Listing 28. AMD: Two-16 bit Devices

# Set devices to Read state
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change p:%%%00000 f0f0f0f0 32bit

# Get Mfg and Device ID values

000

change p:%%%01554 aaaaaaaa 32bit
$00aa8 55555555 32bit

change p:%%%
$01554 90909090 32bit

o
°
o
°

o° oo

change p:

# Display Mfg ID values at offsets 0, 2
# Display Dev ID values at offsets 4, 6
display p:%%%00000..%%%00008 16bit

# Reset devices to Read state
change p:%%%00000 f0f0f0f0 32bit

Listing 29. AMD: Four 16-bit Devices

# Set devices to Read state
change p:%%%00000 fOfO0f0f0f0f0f0f0 64bit

# Get Mfg and Device ID values

000

change p:%%%02aa8 aaaaaaaaaaaaaaaa 64bit
change p:%$%%01550 5555555555555555 64bit
change p:%%%02aa8 9090909090909090 64bit

# Display Mfg ID values at offsets 0, 2, 4, 6
# Display Dev ID values at offsets 8, a, c, e
display p:%%%00000..%%%00010 le6bit

# Reset devices to Read state
change p:%%%00000 fOf0f0f0f0f0f0£f0 64bit

Listing 30. Atmel: One 8-bit Device

# Set device to Read state
change p:%%%05555 aa 8bit
2aaa 55 8bit
5555 f0 8bit

o\

change

p:%%%0
change p:%%%0
# Get Mfg and Device ID values
change p:%%%05555 aa 8bit
change p:%%%02aaa 55 8bit
change p:%%%05555 90 8bit
# Display Mfg ID value at offset O
# Display Dev ID value at offset 1
display p:%%%00000..%%%00002 8bit

# Reset device to Read state
p:%%%05555 aa 8bit

change p:%%%02aaa 55 8bit

change p:%%%05555 f0 8bit

change

Listing 31. Atmel: Two 8-bit Devices
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# Set devices to Read state
change p:%%%0aaaa aaaa 1l6bit
05554 5555 16bit

Qaaaa f0f0 1l6bit

change p:%%%
pP:%%%

change

# Get Mfg and Device ID values
change p:%%%0aaaa aaaa 1l6bit
05554 5555 16bit

Oaaaa 9090 1lebit

change p:%%%
change p:%%%
# Display Mfg ID values at offsets 0, 1
# Display Dev ID values at offsets 2, 3
display p:%%%00000..%%%00004 8bit

# Reset devices to Read state
change p:%%%0aaaa aaaa 1l6bit
change p:%%%05554 5555 1l6bit
change p:%%%0aaaa f0f0 1l6bit

Listing 32. Atmel: Four 8-bit Devices

# Set devices to Read state
change p:%%%15554 aaaaaaaa 32bit
%$0aaa8 55555555 32bit

change %
$15554 fO0f0f0f0 32bit

o° oo

P:%
change p:%

# Get Mfg and Device ID values
change p:%%%15554 aaaaaaaa 32bit
0aaa8 55555555 32bit

change %
%15554 90909090 32bit

oo
Sl
oo
0 °

p:
change p:
# Display Mfg ID values at offsets 0, 1, 2,

# Display Dev ID values at offsets 4, 5, 6, 7
display p:%%%00000..%%%00008 8bit

# Reset devices to Read state

P:%%%

change p:%%%0aaa8 55555555 32bit
p:%%%15554 fO0f0f0f0 32bit

Listing 33. Atmel: One 16-bit Device

# Set device to Read state

change p:%%%0aaaa 00aa 1l6bit
05554 0055 16bit

0aaaa 00f0 16bit

change p:%%%
change p:%%%
# Get Mfg and Device ID values
change p:%%%0aaaa 00aa 1l6bit
05554 0055 16bit
Oaaaa 0090 1lébit

change p:%%%
P:%%%

change
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# Display Mfg ID value at offset 0O
# Display Dev ID value at offset 2
display p:%%%00000..%%%00004 16bit

# Reset device to Read state
change p:%%%0aaaa 00aa 1l6bit
change p:%%%05554 0055 1lébit
change p:%%%0aaaa 00f0 1lébit

Listing 34. Atmel: Two 16-bit Devices

# Set devices to Read state
%%%15554 00aal0aa 32bit
:%$%%0aaa8 00550055 32bit
%%%15554 00f000£f0 32bit
# Get Mfg and Device ID values

change p:%%%15554 00aal0aa 32bit
change 0aaa8 00550055 32bit
15554 00900090 32bit

3}
oo
3}
oo
3}

pP:%%%
change p:%%%
# Display Mfg ID values at offsets 0, 2
# Display Dev ID values at offsets 4, 6

display p:%%%00000..%%%00008 1l6bit

# Reset devices to Read state

change p:%%%15554 00aal0aa 32bit
change p:%%%0aaa8 00550055 32bit
change p:%%%15554 00£000£f0 32bit

Listing 35. Atmel: Four 16-bit Devices

# Set devices to Read state

change p:%%%02998 00aal0aal0aallaa 64bit
change p:%%%01550 0055005500550055 64bit
change p:%%%02aa8 00f000f000£f000£0 64bit
# Get Mfg and Device ID values

$%02998 00aal0aallaallaa 64bit
01550 0055005500550055 64bit

02aa8 0090009000900090 64bit

change p:%
change p:%
change p:%
# Display Mfg ID values at offsets 0, 2, 4, 6

# Display Dev ID values at offsets 8, a, ¢, e
display p:%%%00000..%%%00010 16bit

# Reset devices to Read state

change p:%$%%02998 00aal00aall0aallaa 64bit
change p:%%%01550 0055005500550055 64bit
change p:%$%%02aa8 00f000f000f000£0 64bit
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Listing 36. Intel: One 8-bit Device

# Set device to Read state
# and clear status register
change p:%%%00000 ff 8bit
change p:%%%00000 50 8bit

# Get Mfg and Device ID values
change p:%%%00000 90 8bit

# Display Mfg ID value at offset 0O
# Display Dev ID value at offset 1
display p:%%%00000..%%%00002 8bit

# Read and display status register
change p:%%%00000 70 8bit
display p:%%%00000..%%%00001 8bit

# Reset device to Read state
change p:%%%00000 ff 8bit

Listing 37. Intel: Two 8-bit Devices

# Set devices to Read state
# and clear status registers
change p:%%%00000 ffff 1l6bit
change p:%%%00000 5050 1lé6bit

# Get Mfg and Device ID values
change p:%%%00000 9090 1lé6bit

# Display Mfg ID values at offsets 0, 1
# Display Dev ID values at offsets 2, 3
display p:%$%%00000..%%%00004 8bit

# Read and display status registers
change p:%$%%00000 7070 lébit
display p:%%%00000..%%%00002 8bit

# Reset devices to Read state
change p:%$%%00000 ffff lébit

Listing 38. Intel: Four 8-bit Devices

# Set devices to Read state
# and clear status registers
change p:%%%00000 ffffffff 32bit
change p:%%%00000 50505050 32bit

# Get Mfg and Device ID values
change p:%%%00000 90909090 32bit
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# Display Mfg ID values at offsets 0, 1, 2, 3
# Display Dev ID values at offsets 4, 5, 6, 7
display p:%%%00000..%%%00008 8bit

# Read and display status registers
change p:%%%00000 70707070 32bit
display p:%%%00000..%%%00004 8bit

# Reset devices to Read state
change p:%%%00000 ffffffff 32bit

Listing 39. Intel: One 16-bit Device

# Set device to Read state

# and clear status register
change p:%%%00000 ffff 1l6bit
change p:%%%00000 5050 1lé6bit

# Get Mfg and Device ID values
change p:%%%00000 9090 lé6bit

# Display Mfg ID value at offset 0
# Display Dev ID value at offset 2
display p:%%%00000..%%%00004 16bit

# Read and display status register
change p:%%%00000 7070 lébit
display p:%%%00000..%%%00002 16bit

# Reset device to Read state
change p:%%%00000 ffff leébit

Listing 40. Intel: Two 16-bit Devices

# Set devices to Read state
# and clear status registers
change p:%%%00000 ffffffff 32bit
change p:%%%00000 50505050 32bit

# Get Mfg and Device ID values
change p:%%%00000 90909090 32bit

# Display Mfg ID values at offsets 0, 2
# Display Dev ID values at offsets 4, 6
display p:%%%00000..%%%00007 lebit

# Read and display status registers
change p:%%%00000 70707070 32bit
display p:%%%00000..%%%00003 16bit

# Reset devices to Read state
change p:%%%00000 ffffffff 32bit
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Listing 41. Intel: Four 16-bit Devices

# Set devices to Read state
# and clear status registers
change p:%%%00000 ffffffffffffffff 64bit
change p:%%%00000 5050505050505050 64bit

# Get Mfg and Device ID values
change p:%%%00000 9090909090909090 64bit

# Display Mfg ID values at offsets 0, 2, 4, 6
# Display Dev ID values at offsets 8, a, c, e
display p:%%%00000..%%%00008 1l6bit

# Read and display status registers
change p:%%%00000 7070707070707070 64bit
display p:%%%00000..%%%00004 16bit

# Reset devices to Read state
change p:%%%00000 ffffffffffffffff o64bit

10.7. Examples

Following are example flash interrogations that are common for some target boards that use both AMD
and Intel devices.

10.7.1. One 16-bit AMD Device
Freescale derivatives M5208EVBE, M52277EVB, M5282EVB, and M5235EVB all use AMD 16x1

devices. These devices have Manufacturer ID 0x01.
The commands have been executed on a M5235EVB board. For AMD, one device with 16-bit access
instructs the use of Listing 27.
Perform these steps:
1. Copy this code into text file, check flash.tcl, making the code a script.
2. Substitute the string FFE with all instances of %%%.

3. Use the source command to invoke the script.

Listing 42 shows the resulting code.

NOTE The comment lines in Listing 42 and Listing 43 are for clarification. The CodeWarrior
source command discards comment lines, so you will not see such comments in your
Debugger Shell view.
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Listing 42. Example One Results

# Set device to Read state
change p:FFE00000 f0f0 1l6bit

# Get Mfg and Device ID values
change p:FFE(OOaaa aaaa 1l6bit
change p:FFE00554 5555 16bit
change p:FFEOOaaa 9090 1lé6bit

# Display Mfg ID value at offset 0O
# Display Dev ID value at offset 2
display p:FFE00000..%%%00004 16bit

££e00000 $0001 $2245 $0000 .. "E ..

# Reset device to Read state
change p:FFE00000 f0f0 1l6bit

The results of display line show the manufacturer ID code Ox1 and the device ID code 0x2245. This
confirms basic read/write functionality of the flash devices.

10.7.2. One 16-bit Intel Device
Freescale derivatives M5329EVBE, M5373EVB, M5475EVB, and M5485EVB all use AMD 16x1

devices. These devices have Manufacturer ID 0x89.

The commands have been executed on a M5329EVBE board. For Intel, one device with 16-bit access
instructs the use of Listing 39.
Perform these steps:

1. Copy this code into text file, check flash.tcl, making the code a script.

2. Substitute the string 000 with all instances of %%%.

3. Use the source command to invoke the script.

Listing 43 shows the resulting code.

Listing 43. Example Two Results

# Set device to Read state

# and clear status register
change p:00000000 ffff 1é6bit
change p:00000000 5050 1lébit

# Get Mfg and Device ID values
change p:00000000 9090 1lébit

# Display Mfg ID value at offset O
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# Display Dev ID value at offset 2
display p:00000000..%%%00004 1l6bit

0 $0089 $88C3 $0001
# Read and display status register
change p:00000000 7070 lé6bit
display p:00000000..%%%00002 16bit

0 $0080 $0080

# Reset device to Read state
change p:00000000 ffff 1l6bit

Troubleshooting the Flash Programmer

The result of the first display line shows the manufacturer ID code 0x0089 and the device ID code
0x88C3. This confirms basic read/write functionality of the flash devices.

10.8. Summary

For most flash devices in use today, programming involves state machine like cycles of multiple writes
that must proceed the final write cycle. To diagnose flash programming failures, you must determine
whether the cause of the failure is in target hardware or flash programming software. The general
method of document lets you make this determination through simple, low level writes and reads,

without the use of expensive and complicated logic analyzers. If these reads and writes fail, the problem

most likely is on the target. If these reads and writes succeed, the problem most likely is in the flash
programming software, so contact Technical Support at http://www.freescale.com/support.
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